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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance 
are required to ensure that the products operate safely and without any problems. The permissible ambient 
conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions.

Siemens AG
Digital Industries
Postfach 48 48
90026 NÜRNBERG
GERMANY

Document order number: A5E00730100
Ⓟ 03/2023 Subject to change

Copyright © Siemens AG 2023.
All rights reserved
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Introduction 1
1.1 Purpose of this documentation

These instructions contain all information required to commission and use the device. Read the 
instructions carefully prior to installation and commissioning. In order to use the device 
correctly, first review its principle of operation.
The instructions are aimed at persons mechanically installing the device, connecting it 
electronically, configuring the parameters and commissioning it, as well as service and 
maintenance engineers.

1.2 Document history
The following table shows the most important changes in the documentation compared to each 
previous edition.

Edition Remarks FW version EDD version
03/2023 • Update in General safety instructions

• Adding Manufacturer's design and safe‐
ty statement

• Update in Conformity with European di‐
rectives

• Nameplate update
• Adding Manufacturing locations
• Adding Transporting
• Update in Mains powered transmitter
• Update in FUS380 and FUE380 systems

2.04 1.02.09

09/2021 Nameplate update 2.04 1.02.09
05/2018 • Restructure this document

• Updates in transmitter and sensor con‐
nection

• Adding current output option module
• Adding Accuracy to Technical data
• Responsibility transfer to Siemens AG

2.04 1.02.09

09/2016 • Restructure this document
• Updates for SIMATIC PDM 8.2

2.03 1.02.08-01

09/2013 • Restructure this document
• Adding transmitter information

2.03 1.02.07

09/2011 Update with FW 2.03 2.03 1.02.07
10/2010 Update with FW 1.05 1.05 1.01.04

SITRANS FUS380/FUE380
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Edition Remarks FW version EDD version
12/2009 Update with FW 1.04 1.04 1.01.04
2003 First edition with product release 1.02 1.01.04

The FUS080 is configured in a combination of hardware (HW) and firmware (FW). For 
communication and parametrization via SIMATIC PDM the correct version of the EDD driver 
for FUS/FUE 380 is needed. The various relations are listed above. 

1.3 Items supplied
The device can be delivered as either a compact or a remote system.

Compact system
• Sensor SITRANS FUS300
• Transmitter SITRANS FUS080 or FUE080
• Connection PCB
• DVD with documentation and cerificates
• Safety note
• Calibration report
• Short Siemens sensor link cable
• Connection accessories
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Remote system
• Sensor SITRANS FUS300
• Transmitter SITRANS FUS080 or FUE080
• Connection PCB
• DVD with documentation and cerificates
• Safety note
• Calibration report
• Mounting kit with bracket and terminal box
• Long Siemens sensor link cable
• Connection accessories
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Note
Scope of delivery may vary, depending on version and add-ons. Make sure the scope of delivery 
and the information on the nameplate correspond to your order and the delivery note. 

1.4 Checking the consignment
1. Check the packaging and the delivered items for visible damages.
2. Report any claims for damages immediately to the shipping company.
3. Retain damaged parts for clarification.
4. Check the scope of delivery by comparing your order to the shipping documents for 

correctness and completeness.  
WARNING

Using a damaged or incomplete device
Risk of explosion in hazardous areas.
• Do not use damaged or incomplete devices.

1.5 Further Information

Product information on the Internet     
The Operating Instructions are available on the documentation disk shipped with the device, 
and on the Internet on the Siemens homepage, where further information on the range of 
SITRANS F flowmeters may also be found:
Product information on the internet (http://www.siemens.com/flow) 

Worldwide contact person   
If you need more information or have particular problems not covered sufficiently by these 
Operating Instructions, get in touch with your contact person. You can find contact information 
for your local contact person on the Internet:
Local contact person (http://www.automation.siemens.com/partner) 

1.6 Security information
Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines and networks.

Introduction
1.6 Security information
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In order to protect plants, systems, machines and networks against cyber threats, it is 
necessary to implement – and continuously maintain – a holistic, state-of-the-art industrial 
security concept. Siemens’ products and solutions constitute one element of such a concept.
Customers are responsible for preventing unauthorized access to their plants, systems, 
machines and networks. Such systems, machines and components should only be connected 
to an enterprise network or the internet if and to the extent such a connection is necessary 
and only when appropriate security measures (e.g. firewalls and/or network segmentation) 
are in place.
For additional information on industrial security measures that may be implemented, please 
visit 
https://www.siemens.com/industrialsecurity. 
Siemens’ products and solutions undergo continuous development to make them more 
secure. Siemens strongly recommends that product updates are applied as soon as they are 
available and that the latest product versions are used. Use of product versions that are no 
longer supported, and failure to apply the latest updates may increase customer’s exposure 
to cyber threats.
To stay informed about product updates, subscribe to the Siemens Industrial Security RSS 
Feed under 
https://www.siemens.com/cert. 

1.7 Transportation and storage
To guarantee sufficient protection during transport and storage, observe the following:
• Keep the original packaging for subsequent transportation.
• Devices/replacement parts should be returned in their original packaging.
• If the original packaging is no longer available, ensure that all shipments are properly 

packaged to provide sufficient protection during transport. Siemens cannot assume liability 
for any costs associated with transportation damages.
NOTICE
Insufficient protection during storage
The packaging only provides limited protection against moisture and infiltration.
• Provide additional packaging as necessary.

Special conditions for storage and transportation of the device are listed in Technical 
specifications (Page 93).

1.8 Notes on warranty
The contents of this manual shall not become part of or modify any prior or existing agreement, 
commitment or legal relationship. The sales contract contains all obligations on the part of 
Siemens as well as the complete and solely applicable warranty conditions. Any statements 
regarding device versions described in the manual do not create new warranties or modify the 
existing warranty.

Introduction
1.8 Notes on warranty
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The content reflects the technical status at the time of publishing. Siemens reserves the right 
to make technical changes in the course of further development.

Introduction
1.8 Notes on warranty
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Safety notes 2
2.1 General safety instructions

CAUTION
Correct, reliable operation of the product requires proper transport, storage, positioning 
and assembly as well as careful operation and maintenance.
Only qualified personnel should install or operate this instrument.  

Note
Alterations to the product, including opening or improper modifications of the product are not 
permitted.
If this requirement is not observed, the CE mark and the manufacturer's warranty will expire.
If the equipment is used in a manner not specified by the manufacturer, the protection provided 
by the equipment may be impaired.

2.2 Manufacturer's design and safety statement
• Responsibility for the choice of flowmeter pipe material as regards abrasion and corrosion 

resistance lies with the purchaser. The effect of any change in process medium during 
operation of the meter should be taken into account. Incorrect selection of flowmeter pipe 
material could lead to failure of the flowmeter. 

• Stresses and loading caused by earthquakes, traffic, high winds and fire damage are not taken 
into account during flowmeter design. 

• Do not install the flowmeter such that it acts as a focus for pipeline stresses. External loading 
is not taken into account during flowmeter design.

• Please be aware of the risk of installing the sensor in a highly vibrating environment. Parts 
may shake loose and the complete system must be monitored in that case.

• Flanges and joints as well as related pressure/temperature (p/t) classification has been 
described in EN 1092-1. See ferrite steel group 1E1: table 15.

• During operation do not exceed the pressure and/or temperature ratings indicated on the 
data label or in these operating instructions.

• It is recommended that all installations include an appropriate safety valve and adequate 
means for draining.

• Under the „Pressure Equipment Directive" (PED), this product is a presssure accessory and not 
approved for use as a safety accessory, as defined by the PED.

SITRANS FUS380/FUE380
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Environmental conditions according MID (Directive 2014/32/EU)
• Environment class: E2 (electromagnetic), M1 (mechanical)
• Climatic class: -10°C - +55°C, condensing, closed

Environmental conditions according to IEC 61010-1 (2010)
• Indoor use
• Altitude up to 2000 m
• Maximum relative humidity 80% for temperatures up to 31°C (88°F) decreasing linearly up 
to 50% relative humidity from 40°C (104°F)
• Main supply voltage fluctuations up to -10%/+10% of the nominal voltage (see also 
Technical Specifications (Page 94))
• Overvoltage category II
• Pollution degree 2

2.3 Safety note for bronze sensors

WARNING
Hot water or steam
Potential risk of burns.
Do NOT unscrew bronze sensor during operation (DN 50 to DN 80).

2.4 Conformity with European directives
The CE marking on the device symbolizes the conformity with the following European directives:

Electromagnetic compatibil‐
ity EMC
2014/30/EU

Directive of the European Parliament and of the Council on the 
harmonisation of the laws of the Member States relating to elec‐
tromagnetic compatibility

Low voltage directive LVD
2014/35/EU

Directive of the European Parliament and of the Council on the 
harmonisation of the laws of the Member States relating to the 
making available on the market of electrical equipment designed 
for use within certain voltage limits

Pressure equipment direc‐
tive PED
2014/68/EU

Directive of the European Parliament and of the Council on the 
harmonisation of the laws of the Member States relating to the 
making available on the market of pressure equipment

Safety notes
2.4 Conformity with European directives
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Measuring instruments di‐
rective MID
2014/32/EU

Directive of the European Parliament and the Council on the har‐
monisation of the laws of the Member States relating to the mak‐
ing available on the market of measuring instruments

Restriction of Hazardous 
Substances RoHS
2011/65/EU

Directive of the European Parliament and the Council on the re‐
striction of the use of certain hazardous substances in electrical 
and electronic equipment

The applicable directives can be found in the EU declaration of conformity of the specific 
device.

2.5 Lithium batteries
Lithium batteries are primary power sources with high energy content designed to provide the 
highest possible degree of safety.  

WARNING
Potential hazard
Lithium batteries may present a potential hazard if they are abused electrically or mechanically. 
Observe the following precautions when handling and using lithium batteries:
• Do not short-circuit, recharge or connect with false polarity.
• Do not expose to temperatures beyond the specified temperature range.
• Do not incinerate.
• Do not crush, puncture or open cells or disassemble.
• Do not weld or solder to the battery’s body.
• Do not expose contents to water.

2.6 Installation in hazardous area

WARNING
NOT allowed for use in hazardous areas!
Equipment used in hazardous areas must be Ex-approved and marked accordingly!    
This device is NOT approved for use in hazardous areas!

WARNING
500 V insulation test
The device is not capable of withstanding the 500 V insulation test required by Clause 6.3.12 
of EN60079-11. This must be taken into account when installing the device.

Safety notes
2.6 Installation in hazardous area
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2.7 Improper device modifications

WARNING
Improper device modifications   
Risk to personnel, system and environment can result from modifications to the device, 
particularly in hazardous areas.
• Only carry out modifications that are described in the instructions for the device. Failure to 

observe this requirement cancels the manufacturer's warranty and the product approvals.

Safety notes
2.7 Improper device modifications
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Description 3
3.1 Overview

The SITRANS F US ultrasonic flowmeter systems consist of a sensor and a transmitter. This 
system consists of sensor type FUS300 or SONOKIT and the transmitters type FUS080 or 
FUE080. The transmitter type FUS080 is for the standard flowmeter series SITRANS FUS380 or 
SONOKIT series. The transmitter type FUE080 is for the type-approved flowmeter series SITRANS 
FUE380 with the custody transfer approval for use in energy metering systems. The transmitters 
are designed to measure flow in water applications.
The ultrasonic flowmeter transmitter comes as battery or mains-powered version. 
The following table shows the ultrasonic flowmeter systems with these transmitter types:

Sensor type Transmitter Flowmeter system
FUS300 (2-path)
DN 50 – DN 1200 

FUS080 FUS380 (2-path)

FUS300 (2-path)
DN 50 – DN 1200 (with custody transfer approval 
for use with heatmeters)

FUE080 FUE380 (2-path)

SONOKIT (1- or 2-path)
DN 100 – DN 1200

FUS080 SONOKIT (1-path / 2-path)

These Operating Instructions are only for the FUS380 and FUE380 flowmeter systems. The 
FUS080 for SONOKIT and the SONOKIT sensors have separate Operating Instructions.

3.2 System components
The flowmeter system includes:
• Battery or mains-powered transmitter (FUS080 or FUE080)
• Sensor FUS300 as 2-path inline sensor with flanges, wet-calibrated from factory together 

with the transmitter (DN 50 (2") to DN 1200 (48"))
or the retrofitting set SONOKIT (1-path for pipe diameters from DN 100 (4") up to DN 1200 
(48") or for 2-path from DN 200 (8") up to DN 1200 (48")).

SITRANS FUS380/FUE380
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3.3 Design
The transmitter type SITRANS FUS080 is designed with fiberglass reinforced polyamide 
enclosure for remote or compact installation in normal areas. The remote versions are available 
with up to 30 meter distance from flowmeter to transmitter. In the FUS380 and FUE380 series 
the sensor cables are already mounted at the sensor.

SITRANS FUS080 transmitter SITRANS FUS080 display
The transmitter is available in an IP67/NEMA 4X/6 enclosure and is designed for use in the 
flowmeters series:
• SONOKIT (1-path or 2-path)
• FUS380 (2-path)
• FUE380 (2-path)
For spare part cases the transmitter is always ordered as part of a complete flowmeter 
system, it can be ordered preprogrammed with the given sensor data (system serial number).

3.4 Nameplate layout
The FUS380 or FUE380 flowmeter is delivered with different labels (nameplates) on the 
transmitter and sensor. The transmitter and sensor are matched paired. 
The transmitter has two nameplates. One (silver) is placed on the front of the transmitter. 
The transmitter system nameplate (white) is placed on the right side of the transmitter. Both 
provide valuable information about the device and system. The sensor has one nameplate. 
The sensor system nameplate (white) is placed on the middle of the sensor.

Note
Identification
Identify your device by comparing your ordering data with the information on the product and 
specification nameplates.

Description
3.4 Nameplate layout

SITRANS FUS380/FUE380
18 Operating Instructions, 03/2023, A5E00730100-AG



Transmitter system nameplate

SITRANS FUE380

M18 0200
Siemens AG, DE-76181 Karlsruhe

Made in France

Year of Manuf.: 2018

xxxx....

Pulse value: ...l/p

Pulse width: ... ms

xxxx....

xxxx....

xxxx....

xxxx....

xxxx....

... m

xxxx....

-10°C to +55°C

.../...

DK-0200 MI004-005

2

System No.:

Serial No.:

Transmitter:

Serial No.:

Sensor:

qs:      ...m3/h

qp/qi:  .../...m3/h

Cable length:

Cal. Factor:

T-amb.:

SW/HW V.:

Checksum FW: ........

Certification No.: 

Accuracy Class:

Environmental Class: E2, M1

① Manufacturer
② Product type
③ System number and system serial number
④ Transmitter number and serial number 
⑤ Sensor number and serial number
⑥ Maximum flow value (qs), Nominal flow value (qp), Minimum flow value (qi)
⑦ Cable length (empty for compact version)
⑧ Calibration factor
⑨ Ambient temperature range
⑩ Software version/Hardware version
⑪ Checksum firmware number
⑫ Type approval number (shown on FUE380 versions only)
⑬ Accuracy class (shown on FUE380 versions only)
⑭ Environmental class (shown on FUE380 versions only)
⑮ Verification markings (shown on MID-verified FUE380 versions only)
⑯ Pulse value (output A)
⑰ Pulse width (output A)
⑱ Year of manufacture
⑲ Conformity with country-specific directives
⑳ Warning: Consult the operating instructions

Figure 3-1 Transmitter system nameplate, FUE380 example

Description
3.4 Nameplate layout
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Transmitter system nameplate (back)
1

9

2

3

4

5

7

8

6

10

11

① Manufacturer
② Product type
③ Order number and system serial number
④ Power supply (voltage range, frequency range, power – if applicable)
⑤ IP/NEMA rating
⑥ Ambient temperature range
⑦ Warning note (if applicable)
⑧ Firmware version
⑨ Conformity with country (specific directives)
⑩ QR-code
⑪ Warning: Consult the operating instructions

Figure 3-2 Transmitter system back nameplate, example

Description
3.4 Nameplate layout
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Sensor system nameplate

M18

Siemens AG, DE-76181 Karlsruhe

Made in France

0200

xxxx....

xxxx....

2018

Horizontal

DK-0200-MI004-005

2

E2, M1

System No.

Serial No.:

Year of Manuf.:

Meter orientation:

Certification No.: 

Accuracy Class:

Environmental Class:

xxxx....

xxxx....

DN...

xxxx....

...m3/h

.../... m3/h

+15 °C to +200°C

xxxx....

-10 to +55 °C

             ....bar

             ....bar

             .../...

Sensor:

Serial No.:

Dimension:

Process Con.:

qs:

qp / qi:

Qmin to Qmax:

Cal. Factor:

T-amb.:

MAWP (PS) at ...°C (TS): 

MAWP (PS) at ...°C (TS):

Fluid group:

SITRANS FUE380

① Manufacturer
② Product type
③ Sensor number and serial number
④ Dimension (nominal size ordered)
⑤ Process connections
⑥ Maximum flow value (qs), Nominal flow value (qp), Minimum flow value (qi)
⑦ Water temperature range
⑧ Calibration factor
⑨ Ambient temperature range
⑩ Maximum allowable working pressures at 15 °C (59 °F) and 200°C (392 °F) (max. temperature 

(TS))
⑪ Fluid group
⑫ System number and system serial number
⑬ Year of manufacture
⑭ Meter orientation
⑮ Type approval number (shown on FUE380 versions only)
⑯ Accuracy class (shown on FUE380 versions only)
⑰ Environmental class (shown on FUE380 versions only)
⑱ Conformity with country-specific directives
⑲ Warning: Consult the operating instructions
⑳ Verification and PED markings (verification marking shown on MID-verified FUE380 versions 

only)
Figure 3-3 Sensor system nameplate, FUE380 example

Note
The matched paired transmitter and sensor shall be mounted together
At installation, please check that the system nameplates of transmitter and sensor have the 
same system serial number. 

Description
3.4 Nameplate layout

SITRANS FUS380/FUE380
Operating Instructions, 03/2023, A5E00730100-AG 21



3.5 Features
The following features are available:
• Battery or mains-powered transmitter
• Battery-powered with 3.6 V Lithium dual D-cell batteries
• Suitable for sensor pipe diameters from DN 50 (2") up to DN 1200 (48")
• IP67 (NEMA 4X/6) rated polyamid transmitter enclosure
• Factory preset to the nominal dimensions of pipe type and pipe size
• Programming via SIMATIC PDM
• Local control panel with single push button, 8-digit display and IrDA optical interface for 

communication with SIMATIC PDM
• Display showing accumulated volume as well as instantaneous flow rate. The displayed units 

are m3 and m3/h
• Two digital outputs for volume pulse or alarm
• 4-20 mA output (optional)

Applications
The main application for flowmeters type SITRANS FUS380 / SONOKIT and the type-approved 
version FUE380 is measurement of water flow in district heating plants, local networks, boiler 
stations, substations, chiller plants, irrigations plants, and other general water applications.

Integration
The flowmeter pulse output is often used as input for an energy meter or as input for digital 
systems for remote reading. The transmitter has two pulse outputs, with functions that can be 
individually selected, and integrated IrDA (optical eye) communication interface (Modbus RTU).
The settings of the transmitter, for example flow and pulse output rate, are defined when 
ordering the complete flowmeter. If the flowmeter forms part of an energy meter system for 
custody transfer, no further approvals are needed, except eventually local approvals on the 
flowmeter.

Transmitter communication solutions
The parametrization of the device is done with an device specific Electronic Device Description 
(EDD) which is part of the product delivery. The EDD can be loaded by the the SIMATIC PDM 
software. The communication protocol between SIMATIC PDM and the device is MODBUS RTU. 
The communication goes through the IrDA interface of the device. To connect the IrDA interface 
with a PC an IrDA adapter is needed. The following table shows the compatibility between the 
firmware (FW) and the EDD.

FW version EDD version
1.02 to 1.05 1.01.04 (with SIMATIC PDM 6 versions)
2.03 1.02.07 (with SIMATIC PDM 6 versions)

Description
3.5 Features
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FW version EDD version
2.03 1.02.08-01 (min. SIMATIC PDM 8 versions)
2.04 1.02.09 (min. SIMATIC PDM 8 versions)

3.6 Principle of operation

Physical principle   

Figure 3-4 Velocity distribution along sound path
A sound wave travelling in the same direction as the liquid flow arrives at point B from point 
A in a shorter time than the sound wave travelling against the flow direction (from point B to 
A).
The difference in sound travel time indicates the flow velocity in the pipe.
Since delay time is measured at short intervals both in and against flow direction, 
temperature has no influence on measurement accuracy.

SITRANS F US flowmeters
In SITRANS F US flowmeters the ultrasonic transducers are placed at an angle θ in relation to the 
pipe axis. The transducers function as transmitters and receivers of the ultrasonic signals. 
Measurement is performed by determining the time the ultrasonic signal takes to travel with and 
against the flow. The principle can be expressed as follows:
v = K × (tB,A – tA,B) / (tA,B × tB,A) = K × Δt/t²
where
v = Average flow velocity
t = Travel time
K = Proportional flow factor      
This measuring principle offers the advantage that it is independent of variations in the 
actual sound velocity of the liquid, i.e. independent of the temperature.
The mechanical/geometrical pipe data is transducer angle (θ), distance between sensors (L) 
and pipe dimension (Di and Du) shown in the figure below. 

Description
3.6 Principle of operation
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1A

1B

Figure 3-5 Measuring principle
The ultrasonic signal is sent directly between the transducers. The advantage gained by 
sending signals from point to point is an extremely good signal strength.

Manufacturing locations
The SITRANS FUS380 and SITRANS FUE380 are manufactured on the following locations:
1. Siemens Sas Division Production Sensors And Communication
1 Chemin de la Sandlach
Haguenau Cedex 67506 
France
2. Siemens Sensor And Communication Co Ltd
High-Tech Park
117 Guangxian Rd
Dalian Liaoning 116023
China

Description
3.6 Principle of operation
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Installing/Mounting 4
4.1 Flowmeter installation

The flowmeter installation is done in two steps: 
1. Sensor installation
2. Transmitter installation
The devices have to be installed in a zone where access is restricted to authorized personnel 
only.

Environment
SITRANS F flowmeters are suitable for indoor and outdoor installations.
• Make sure that temperature and ambient specifications indicated on the device type plate/

label are not exceeded.    

CAUTION
Direct sunlight and mechanical forces
Device damage.
The device and its cables can overheat or materials become brittle due to UV exposure.
Protect the device and its cables from direct sunlight and mechanical forces.
Make sure that the maximum permissible ambient temperature is not exceeded. 
Refer to the technical data in FUS380 and FUE380 systems (Page 94).

Ambient temperatures for FUS080:
• MID version: -10 to +55 °C (14 to 131 °F)
• Non-MID version: -10 to +60 °C (14 to 140 °F)
See also Insulation (Page 30).
The enclosure rating of the transmitter is IP67 (NEMA 4X/6) or better.

4.2 Sensor installation

4.2.1 Inlet/outlet conditions
Requirement for straight inlet before flowmeter

SITRANS FUS380/FUE380
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In order to maximize performance it is necessary to have straight inlet and outlet flow 
conditions before and after the flowmeter.
Furthermore, a minimum distance between flowmeter and pumps and valves must be 
observed.
It is also important to centre the flowmeter in relation to flanges and gaskets.
Make sure that the flowmeter is positioned as low as possible to prevent air from being 
trapped in the flowmeter at the transducers.
Find a position on the pipeline where the inlet pipe to the flowmeter has a straight length as 
specified below.

Note
MID-approved FUE380 systems
Minimum straight inlet pipe: 10 x pipe diameter, minimum 1 m. See further recommendations 
below.

Single bend
1 x 90° bend
L2: Min. 10 x pipe diameter
L1: 3 x pipe diameter

Dual bend
2 x 90° bends in the same plane
L2: Min. 10 x pipe diameter
L1: 3 x pipe diameter

Installing/Mounting
4.2 Sensor installation
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Triple bend
3 x 90° bends in two planes
L2: Min. 20 x pipe diameter
L1: 3 x pipe diameter

Valves and pumps
Valves
L2: Min. 10 x pipe diameter, fully open valve
L1: 3 x pipe diameter
Partially opened valves
L2: Min. 40 x pipe diameter, partially opened valves (or equal valves design) 
Pumps
L2: Min. 40 x pipe diameter
L1: 3 x pipe diameter

Installing/Mounting
4.2 Sensor installation
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Orienting the sensor
Horizontal orientation: sensors must be mounted with the terminal box in upwards or 
downwards position.

In horizontal installation avoid any upward/downward position of the transducers.

Installing/Mounting
4.2 Sensor installation
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Precautions
Avoid installation at the highest point in the system because air bubbles will be trapped in the 
flowmeter.
Avoid installation at a point where there is a free outlet after the flowmeter.

The flowmeter pipe section may be installed in either a horizontal or vertical position.

Note
To obtain maximum battery lifetime of the Lithium Thionyl Chloride battery pack, Siemens 
recommends installing the flowmeter transmitter in an upright position.

4.2.2 Reduction
Installation in large pipes
The flowmeter can be installed between two reducers as shown. At 8° reducing angles the 
below pressure drop curve applies.

Delta-P example:
A water flow velocity of 3 m/s (V) in a sensor with a diameter reduction from DN 200 to DN 
100 (D1/D2 = 0.5) gives a pressure drop of 9 mbar.
L2: Min. 10 x pipe diameter

Installing/Mounting
4.2 Sensor installation
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4.2.3 Insulation
Siemens always recommends insulation of the sensor in both the compact and the remote 
versions. This recommendation applies to both battery-powered and mains-powered versions. 
The insulation will prevent heat transfer to the transmitter (compact versions) or terminal box 
(remote versions).
For media temperatures above 120 °C (248 °F) only remote installation is allowed.

Installing/Mounting
4.2 Sensor installation
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Temperatur specifications for non-insulated sensors

FUS 380

FUE 380

  ① Compact and remote versions
② Remote versions only

Temperatur specifications for insulated sensors

2

FUE 380

FUS 380

① Keep terminal box free from insulation (gray area)
② Insulation

① Compact and remote versions
② Remote versions only

4.3 Transmitter installation (compact/remote versions)
The transmitter is packed separately - ready for plug-in into base part.
There are two mounting versions of the transmitter (as shown in figures below):
• remote transmitter
• compact transmitter

Installing/Mounting
4.3 Transmitter installation (compact/remote versions)
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Remote transmitter
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Compact transmitter

Note
The matched paired transmitter and sensor must be mounted together. At installation, please 
check that the system nameplates of transmitter and sensor have the same system serial 
number.

4.3.1 Installation wall mounting kit (remote transmitter)
Mount wall/pipe mounting bracket in an appropriate place.

67 66      57 56

67 66      57 56

67 66      57 56

Note
Take the Siemens sensor link cable length into consideration, and allow adequate space for the 
cable inlets.

Installing/Mounting
4.3 Transmitter installation (compact/remote versions)
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4.4 Transporting

Transporting

WARNING
Lifting the sensor 
Do NOT lift the sensor by the terminal box. Do NOT use a forklift. If available lift the sensor by 
the lifting eyes fitted to the device. Otherwise lift the sensor by the process connections.

CAUTION
Flange devices ≤ DN 300
• Use carrying straps to transport devices with flange sizes smaller than DN 300.
• Wrap the carrying straps around both process connections when lifting the device.
• Chains should not be used, since these may damage the enclosure.

Figure 4-1 Incorrect transportation

Figure 4-2 Correct transportation

Installing/Mounting
4.4 Transporting
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Installing/Mounting
4.4 Transporting
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Connecting 5
SITRANS FUS380 and FUE380 is delivered in one of the three versions:
• Battery-powered only
• Mains-powered
• Mains-powered with battery back-up
Determine the transmitter power source type by reading the label or via the product code.

NOTICE
Verification sealing
SITRANS FUE380 systems are protected by a verification sealing. The verification sealing must 
only be broken by the user with the acceptance of the local authorities. 

Note
Power supply
A transmitter ordered as only battery-powered cannot be updated with additional mains power, 
as no mains power supply circuits are installed in this transmitter type.

WARNING
Skills
Only qualified personnel may carry out work on the electrical connections.

WARNING
Danger of electric shock!
Never install the device with the mains voltage switched on!

5.1 Mains-powered transmitter
The mains-powered transmitter can be ordered with a pre-mounted single back-up lithium 
battery. In the event of power failure, the battery will take over the power supply of the unit.
The battery is not rechargeable, it must be replaced after maximum 6 years.

Note
The male battery plug is not connected upon delivery. This connection must be made to enable 
the back-up battery power supply.

SITRANS FUS380/FUE380
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Note
Protected terminal
The wire sizes for the mains-powered terminals are AWG24 to AWG16 or 0.205 mm2 to 1.500 
mm2.

The mains circuit as well as the cable for the mains-powered terminal must be equipped with 
a Protective Earth. The cable for the mains powered terminal must comply IEC 60227 or IEC 
60245.
A protection has to be installed upstream to the device, in the form of a 6A circuit breaker or 
a 1500A breaking capacity fuse.
When used with a cable gland, the mains cable section has to be 5 to 9 mm in size.
The mains cable must comply to IEC 60227 or IEC 60245.
Take special precautions when installing the mains cable near pipes with high temperature 
fluids.
An external overcurrent protection device has to be installed in the circuit.
A switch or circuit breaker must be included in the electrical installation for safely 
disconnecting the device.
Install the circuit breaker on easily accessible location and mark it as the disconnecting device 
for the transmitter.

5.2 Battery-powered transmitter
The battery-powered transmitter is prepared for one battery pack of 2 lithium 3.6 V D-cell 
batteries. The battery lifetime depends on the use of the different functions, for example the use 
of Modbus IrDA communication or higher pulse output frequency will decrease the lifetime 
significantly. Under normal temperature and working conditions a battery can have an 
operation lifetime of up to 6 years. The typical liftetime of a dual battery pack with nominal 
working pulse output frequency of 20 Hz is approximately 4.2 years.
Siemens recommends replacing batteries after maximum 6 years. For the replacement, see 
Battery replacement (Page 75). Every time a battery plug is reconnected, the unit runs a 
start-up routine, see Start-up routine (Page 56).

Note
The male battery plug is not connected upon delivery. This connection must be made to enable 
the back-up battery power supply.

Note
Changing the battery does not influence the settings and accumulated values.

Connecting
5.2 Battery-powered transmitter
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5.3 Compact system
The following chapters describe how to connect a compact system. If you want to connect a 
remote system proceed with chapter Remote system (Page 42).
1. Connecting battery (battery-powered versions and mains-powered versions with back-up 

battery) (Page 37)
2. Connecting Siemens sensor link cable (Page 38)
3. Connecting power supply cable (main-powered systems only) (Page 39)
4. Connecting pulse output signal cable(s) (Page 40)
5. Finishing connection (Page 41)

5.3.1 Connecting battery (battery-powered versions and mains-powered versions 
with back-up battery)

Plug in male battery plug. Ensure that the wire is inserted into the small channel leading from 
plug to battery.

Connecting
5.3 Compact system
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5.3.2 Connecting Siemens sensor link cable
1. Remove the plastic lid from the terminal box.
2. Click the Siemens sensor link cable onto sensor connection board (A) and onto transmitter 

connection board (B).

A

B

3. Turn the transmitter connection board so that the connection cable is facing downwards.

67 66      57 56

3

4

2

4. Click the transmitter connection board into the terminal box.
5. Connect protective earth wire.

67 66      57 56

Connecting
5.3 Compact system
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5.3.3 Connecting power supply cable (main-powered systems only)

WARNING
Power supply requirements
Make sure the power supply requirements stated on the nameplates are met!

WARNING
Wire insulation   
The insulation between the connected mains supply and the low voltage supply for the 
flowmeter must be rated with at least double or reinforced insulation at mains voltage.
For field wiring installation: Ensure that the National Installation Code of the country in which 
the flowmeters are installed is met.

Note
Conductor terminal     
The wire size for the output terminals are AWG24 to AWG16 or 0.205 mm2 to 1.500 mm2.

1. Replace blind plug with cable gland.
2. Push power supply cable through open gland.
3. Connect power supply to L1, N and protective earth (PE) and tighten cable strap (C).

C

4. Tighten cable gland for power supply cable (approx. 20 Nm).

Connecting
5.3 Compact system
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5.3.4 Connecting pulse output signal cable(s)
If no output signals are needed, proceed with "Finishing connection".

CAUTION
Pulse output
The pulse output must be connected to equipment complying with Low-Voltage Directive in 
order to be considered safe. The isolation within FUS080 pulse output is only a functional 
isolation.

1. Replace blind plug with cable gland (if two output signals are required, use a double entry 
cable gland).

2. Push output cable(s) through open gland.
3. Connect output cable(s). Only SELV circuits are allowed to be connected to FUS080 pulse 

output.

4. Tighten cable gland for output cable(s) (approx. 20 Nm).

Note
Cables with voltage
Keep the output signal cable(s) separated from cables with voltages > 60 V.

Note
Ingress protection
To guarantee the IP67 (NEMA 4X/6) degree of protection, use cables with the required 
specifications.

Connecting
5.3 Compact system
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Note
Protected terminal
The wire size for the mains-powered terminals are AWG24 to AWG16 or 0.205 mm2 to 
1.500 mm2.

Note
EMC performance
Incorrect fixing of the output cable shield will affect the EMC performance.

Note
Optional current output module
If you want to install the optional current output module, proceed with chapter Installing and 
connecting optional current output module (Page 48) before mounting the transmitter.

5.3.5 Finishing connection
Mount the transmitter.

Note
Grounding
To ensure identical potential for sensor and transmitter, a direct grounding of transmitter and 
sensor is recommended.

Note
Aligning the gasket
Please ensure that the gasket between terminal box and transmitter is well aligned before 
tightening the screw (Min. torque 0.5 Nm).

Connecting
5.3 Compact system
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5.4 Remote system
The following chapters describe how to connect a remote system. If you want to connect a 
compact system proceed with chapter Compact system (Page 37).
On sensor side:
1. Connecting Siemens sensor link cable (Page 42)
2. Finishing connection (Page 43)
On transmitter side:
1. Connecting battery (battery-powered versions and mains-powered versions with back-up 

battery) (Page 43)
2. Connecting Siemens sensor link cable (Page 44)
3. Connecting power supply cable (main-powered systems only) (Page 45)
4. Connecting pulse output signal cable(s) (Page 46)
5. Finishing connection (Page 47)

5.4.1 Sensor side

5.4.1.1 Connecting Siemens sensor link cable
1. Remove terminal box lid.
2. Remove a blind plug.
3. Push connection cable through opening.
4. Click connection cable onto sensor connection board (A).

A

5. Mount and tighten cable gland (approx. 20 Nm).

Connecting
5.4 Remote system
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5.4.1.2 Finishing connection
Remount terminal box lid.

Note
Hot surfaces
Ensure that the connection cable does not come into contact with a hot sensor/metering tube.

Note
Grounding
To ensure identical potential for sensor and transmitter, a direct grounding of transmitter and 
sensor is recommended.

5.4.2 Transmitter Side

5.4.2.1 Connecting battery (battery-powered versions and mains-powered versions with 
back-up battery)

Plug in male battery plug. Ensure that the wire is inserted into the small channel leading from 
plug to battery.

Connecting
5.4 Remote system
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5.4.2.2 Connecting Siemens sensor link cable
1. Remove blind plug.
2. Push the Siemens sensor link cable through the opening.
3. Click the Siemens sensor link cable onto transmitter connection board (B).

B

4. Turn transmitter connection board so connection cable is facing downwards.
5. Click transmitter connection board into terminal box.

67 66      57 56
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6. Mount and tighten cable gland (approx. 20 Nm).
7. Connect protective earth wire.

67 66      57 56

Connecting
5.4 Remote system
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Note
Cables with voltage
Keep the connection cable separated from cables with voltages > 60 V.

5.4.2.3 Connecting power supply cable (main-powered systems only)

WARNING
Power supply requirements
Make sure the power supply requirements stated on the nameplates are met!

WARNING
Wire insulation   
The insulation between the connected mains supply and the low voltage supply for the 
flowmeter must be rated with at least double or reinforced insulation at mains voltage.
For field wiring installation: Ensure that the National Installation Code of the country in which 
the flowmeters are installed is met.

Note
Conductor terminal     
The wire size for the output terminals are AWG24 to AWG16 or 0.205 mm2 to 1.500 mm2.

1. Replace blind plug with cable gland.
2. Push power supply cable through open gland.
3. Connect power supply to L1, N and protective earth (PE) and tighten cable strap (C).

C

4. Tighten cable gland for power supply cable (approx. 20 Nm).

Connecting
5.4 Remote system
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5.4.2.4 Connecting pulse output signal cable(s)
If no output signals are needed, proceed with "Finishing connection".

CAUTION
Pulse output
The pulse output must be connected to equipment complying with Low-Voltage Directive in 
order to be considered safe. The isolation within FUS080 pulse output is only a functional 
isolation.

1. Replace blind plug with cable gland (if two output signals are required, use a double entry 
cable gland).

2. Push output cable(s) through open gland.
3. Connect output cable(s). 

4. Tighten cable gland for output cable(s) (approx. 20 Nm).

Note
Cables with voltage
Keep the output signal cable(s) separated from cables with voltages > 60 V.

Note
Ingress protection
To guarantee the IP67 (NEMA 4X/6) degree of protection, use cables with the required 
specifications.

Connecting
5.4 Remote system
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Note
Protected terminal
The wire size for the mains-powered terminals are AWG24 to AWG16 or 0.205 mm2 to 
1.500 mm2.

Note
EMC performance
Incorrect fixing of the output cable shield will affect the EMC performance.

Note
Optional current output module
If you want to install the optional current output module, proceed with chapter Installing and 
connecting optional current output module (Page 48) before mounting the transmitter.

5.4.2.5 Finishing connection
Mount the transmitter.

Note
Grounding
To ensure identical potential for sensor and transmitter, a direct grounding of transmitter and 
sensor is recommended.

Note
Aligning the gasket
Please ensure that the gasket between terminal box and transmitter is well aligned before 
tightening the screw (Min. torque 0.5 Nm).

Connecting
5.4 Remote system
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Note
Remote connection cable
If the Siemens sensor link cable is shortened, the factory set "Cable length" setting must be 
corrected. 
This setting can only be changed if the HW key is mounted, which requires demounting of the 
transmitter. In case the FUE380 is protected by a physical verification sealing, this must be 
broken which may only be done with the acceptance of the authorities.

5.5 Optional current output module
The optional current output module converts the flow signal into a 4-20 mA output signal. The 
4 mA always equals 0 flow rate and the 20 mA equals the Qp value selected via the order code. 
The default Qp can be found on the transmitter nameplate.
The current output module is passive and therefore needs an external power supply.

Note
Current output range during start up
When the current output module is enabled (default setting) the output is 3.6 mA during start 
up.
When the current output module is disabled the output is fixed to 4 mA. 

Note
Restricted use of the optional current output module
The module can be used with all mains-powered FUS/FUE380 versions, but the output signal is 
not approved for custody transfer use.

5.5.1 Installing and connecting optional current output module

WARNING
Danger of electric shock!
Never install the device with the mains voltage switched on!

CAUTION
EMC performance
Current output cable shield must be connected. Incorrect fixing of the cable shield may affect 
the EMC performance!

Connecting
5.5 Optional current output module
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Note
Power supply
The current output module is a passive module and should only be used with external power 
supply.

Note
Current output module
To support the function with current output module the default communication settings for the 
transmitter is recommended. See Factory settings for Modbus communication (Page 118).

Installing
1. Remove transmitter/terminal box lid.
2. Carefully mount current output module on the eight pins.

3. Fasten module to transmitter connection board by use of a M3x5 screw (0.5 Nm).

CAUTION
Protective earth
The M3x5 screw also functions as earth conductor (EMC).

See also
Optional current output module (Page 95)

Connecting
5.5 Optional current output module
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5.5.2 Connecting
The output terminals are marked 31 and 32 with corresponding polarity + and - on the terminal 
strip. The connector  is for shielding.
The requirements for the current output cable, for example max. load can be found in 
Optional current output module (Page 95).
1. Replace blind plug with cable gland (if two output signals are required, use a double entry 

cable gland).
2. Push output cable through open gland.
3. Connect output cable to terminals 31, 32 and .

① Heat shrink tube
② Shield
③ 8.5 to 36 VDC

4. Tighten cable gland for current output cable (approx. 20 Nm).

5.5.3 Finishing connection
Mount the transmitter.

Note
Grounding
To ensure identical potential for sensor and transmitter, a direct grounding of transmitter and 
sensor is recommended.
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Note
Aligning the gasket
Please ensure that the gasket between terminal box and transmitter is well aligned before 
tightening the screw (Min. torque 0.5 Nm).

5.6 Wiring energy calculator
An energy calculator is typically connected via the pulse output A (terminals 56 and 57) of the 
transmitter.
For example, connection to the energy calculator SITRANS FUE950 can be found in the 
operating instruction of the FUE950.

Note
The maximum pulse frequency between Sitrans FUS/FUE380 and SITRANS FUE950 should not 
exceed 20 Hz.

Siemens does not recommend using a higher transmission speed with other energy 
calculators. At higher transmission speeds, pulses can be lost.

5.7 Sealing of FUE380

5.7.1 User sealing
After finishing the installation and electrical connection of SITRANS FUE380 types, it is 
recommended to seal the flowmeter as shown. Drill through marked drilling holes in terminal 
box and transmitter/lid. Seal the transmitter on both sides with either one or two wires.

Transmitter Sensor Remote version
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5.7.2 Verification sealing
These illustrations show how the device is verification sealed.
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Note
For type-approved and verified FUE380 flowmeters
The HW key is located behind the display and is thereby protected by the display sealing.
The verification sealing may only be broken with the acceptance of the local authorities.
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Commissioning 6
6.1 Introduction

Commissioning the device includes the following steps:
1. Resetting the battery lifetime (see Start-up routine (Page 56)).
2. Checking values in the service menu.
3. Configuring the device via SIMATIC PDM (see Commissioning via PDM (Page 56)).
Before commissioning, a basic guide to the local display and the menu structure is offered 
in the chapters: Operating the local display (Page 54) and Navigating the menu structure 
(Page 55).

6.2 Local user interface
The device is operated with the optical keypad on the operating and display panel. The keypad 
are operated by touching the appropriate fields on the glass panel with your fingertips.

  Name Function
① Display (LCD) Menu display
② Optical key Menu selection and display information
③ Infrared key Optical communication and control interface with Modbus RTU protocol 

for read or write transmitter settings and data via PC and PDM tool
Figure 6-1 Keypad and display layout
The operator menu is for daily operation. It is customized in the operator menu setup. The 
functions are described in Human Interface parameters chapter (Page 114).

Note
IP protection
Operation does not require opening of the device. This means that a high degree of protection 
is guaranteed at all times.
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6.3 Operating the local display
The local display is divided into 3 areas:   
• Top area with symbols for status information
• Mid area with actual readings
• Lower area with index number of the shown menu or the service menu symbol (  ).
Activate the push button to go the next index menu and related information. The service 
menu is accessible from all menus by pressing the push button for minimum 2 seconds.

Figure 6-2 Operating the local display

Table 6-1 Status information symbols
Symbol Description

Mains power supply connected

Battery charge status
Warning
Service menu

Battery status
There are two symbols for battery charge status:
• "Battery full" indicates battery charge above the warning level (6-year hour counter).
• "Battery low" indicates battery charge below the warning level and that the battery should be 

replaced. 

Note
"Battery low" only indicates that battery charge is below a pre-set level, not that charge is zero.
Flow measurement continues uninterrupted until the battery is completely drained.
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Table 6-2 Battery status information symbols
Symbol Description

Battery status, full
Battery status, low

6.4 Navigating the menu structure
Press the push button briefly (less than 2 seconds) to navigate between the following menu 
items:

Table 6-3 Menu items   
Menu Parameter Display example Comments
Menu 1 Flow volume totalizer 1 Factory preset is forward vol‐

ume flow.
The battery symbol shows full.

Menu 2 Flow volume totalizer 2 Factory preset for reverse 
flow.
Negative values indicate re‐
verse flow calculation.

Menu 3 Actual flow rate Negative values indicate re‐
verse flow calculation.

Menu 4 Alarm codes Each code refers to a specific 
alarm.

Menu 5 Display test Check of all segments. Display 
toggles between all segments 
on/off.

Table 6-4 Service menu
Menu Parameter Display example Comments

Service menu The service menu is accessi‐
ble from all menus by press‐
ing push button for minimum 
2 seconds. For more informa‐
tion on the complete service 
menu, see Service menu 
(Page 78).
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6.5 Start-up routine
1. Power-up device.
2. Reset battery status indicator as described below (battery-powered versions only).

Resetting the battery counter   

Note
The reset can also be carried out via SIMATIC PDM.

When a new battery is installed and the plug is connected, the transmitter start-up routine 
begins. The display shows the actual software version, e.g. 2.04.
After ten seconds the message reset.bat will appear.
1. Press push button within six seconds to reset the internal battery counter. The 

message accept will appear.
2. Press push button again within six seconds in order to reset the internal battery counter. 

The battery indicator now shows . If the push button is not pressed again, the battery 
indicator will show .

Figure 6-3 Reset internal battery counter
* Firmware version

6.6 Commissioning via PDM
SIMATIC PDM (Process Device Manager) is a software package for configuring, parameterizing, 
commissioning, and maintaining field devices.     
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Among other features, SIMATIC PDM contains a simple process for monitoring process values, 
interrupts and status/diagnosis signals of a field device.

Note
For instructions on installation and operation of SIMATIC PDM, refer to the SIMATIC PDM Getting 
Started (included in the documentation package that comes with PDM).

Note
PDM requirements
Minimum PDM version required is SIMATIC PDM V8.2 + SP1. The required operating system to 
install SIMATIC PDM is Windows 7.

Note
Default password
Any data changes in PDM require a password. The default password is 1000. For further 
information, see Password-protected data (Page 72).

Note
Hardware (HW) key protected parameters
For type-approved and verified FUE380 flowmeter the settings are HW key protected and can be 
only read, but not changed via PDM. The HW key is located behind the display and is thereby 
protected by the display sealing. The verification sealing may only be broken with the acceptance 
of the authorities.

In the following it is described how the device is commissioned using SIMATC PDM.
The commissioning is divided into the following steps:
1. Installing and connecting the IrDA interface adapter (Page 57)
2. Installing the device driver (Page 59)
3. Adding the device to the network (Page 61)
4. Configuring the device (Page 62)
5. Optimizing the system (Page 63)
6. Checking the operation readiness (Page 68)

6.6.1 Installing and connecting the IrDA interface adapter

Note
IrDA driver installation
For installation of the IrDA driver, refer to the instructions delivered with the adapter. The 
required operating system to install SIMATIC PDM and the IrDA driver is Windows 7.
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1. Connect IrDA adapter to PC

2. Mount adapter on FUS080
When the IrDA adapter is connected correctly, a small icon appears on the taskbar of your PC. 
When the mouse is placed on this icon, the device information will be shown (e.g. [FUS080 
SN1033 is in range]).
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6.6.2 Installing the device driver
Install the PDM device driver as follows:     
1. Close SIMATIC PDM (if already open).
2. Open Device Integration Manager from [Start → All Programs → Siemens Automation 

→ SIMATIC → SIMATIC PDM].
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3. Click on [I accept the License Agreement].

4. Click on  or  depending on whether the source is zipped or not.
5. Browse to the folder where the source files are located and click on the folder.
6. The device will show up in a tree view. Mark the device to be installed and click on  to 

install the driver on the PC.

Note
Please use for the firmware FW 2.03 the related EDD 1.02.08-01.
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6.6.3 Adding the device to the network
It is recommended to configure the FUS080 project in PDM before setting the parameters. 
Add device to SIMATIC Modbus network: 
1. Select [File → New]

Type in a project name.
2. Right click on your new project, select [Insert New Object → Networks].
3. Right click on your Networks, select [Insert New Object → Communication Network].
4. Click on [Assign Device Type] and select Networks → MODBUS → MODBUS networks 

→ MODBUS network.

5. Click [OK] and click [OK] again.
6. Right click on MODBUS network and select [Insert New Object → Object]
7. Click on [Assign Device Type] and assign the MODBUS device to SITRANS FUS/E080 [Devices 

→ MODBUS → Sensors → Flow → Ultrasonic → SIEMENS AG → SITRANS FUS/E080] and 
click [OK].
Name device according to application requirements (max. 32 characters) and click [OK].
Set up communication parameters for SIMATIC MODBUS network.

8. Select Networks → MODBUS network.
9. Right click on Modbus network and select Object Properties.
10.On the Communication tab, select MODBUS communication to activate IrDA.
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6.6.4 Configuring the device
In the following it is described how to configure the device by defining all sensor specific 
parameters.

Note
Measurement accuracy
A correct flowmeter installation is required to ensure optimum measurement accuracy.

Read all parameters
Before any parameterization is done it is necessary to read all parameters from the device into 
the offline table of SIMATIC PDM. The offline table merely contains default data.
1. Open PDM device driver.
2. Select Upload to PG/PC .. and click [Start] to read all parameters to the offline table. 

After closing the dialog box, all loaded parameters should show  (Loaded) in the status 
of the PDM table; except date and time formats, they show  (Changed).  

3. Store factory set default values on your local PC [File → Export] in order to be able to retrieve 
default settings.
 

Read, write device data
Only parameters (data) shown with white background can be changed.

Note
Status field
•  indicates changed off-line data not yet stored in the device.
•  indicates actual data downloaded to the device.
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Load the parameters to the device by clicking on . Check the option [Load changed 
parameters only] to speed up the communication and avoid errors.
For overview of the parameters see Parameter lists.

6.6.5 Optimizing the system
After storage of the settings, the parameters can be set according to use.
The following shows how to set Pulse Output A and Qmax. For other parameters, refer to 
"Parameter list" in the appendix.
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Setting Pulse Output and Maximum Flow (Qmax) via SIMATIC PDM
1. In SIMATIC PDM navigate to menu [Device → Pulse guide].

The "guide" calculates the pulse-frequency at the max flow condition and tells you how close 
you are on over-speeding the pulse-output. 
The volume per pulse is freely scalable from 0.000001 to 10000 units per pulse. It also 
calculates the minimum volume per pulse you can choose to avoid pulse over-speeding. 
The maximum output frequency depends on the pulse selected; e.g. maximum output 
frequency at 5 ms is 100 Hz. Increasing the pulse width lowers the maximum output 
frequency.

2. Select maximum flow rate (never to be exceeded).
3. Select an appropriate pulse width, e.g. 5 ms.
4. Enter a value in Amount per pulse A, e.g. 100, to define the volume/pulse with respect to 

the Minimum amount per pulse value.
5. Press [Apply Change of Pulse] to apply the settings.
6. If needed, proceed with setting Pulse Output B according to application specific requirements 

(Default setting = Alarm).

Output A and B setting
For FUS380 and FUE380, output A and B settings depend on the ordering: Recommended 
settings, see the following table. Settings for FUS380 can be read out and changed via SIMATIC 
PDM (Process device manager). To fulfill type approval requirements some settings for FUE380 
are HW locked.

  FUS380 FUE380
Output A Forward or reverse pulses

Preset: Forward
Forward pulses only
Preset: Forward setting is HW locked

Output B Forward or reverse pulses, alarm, call-up
Preset: Alarm

Forward or reverse pulses, alarm, call-up
Preset: Alarm

Pulse value A
(depending on DN value)

Preset: Depending on ordered configura‐
tion. Selection is noted on nameplate.
Possible presets: 0.1 l/p; 0.25 l/p; 0.5 l/p; 
1 l/p; 2.5 l/p; 10 l/p; 25 l/p; 50 l/p; 100 l/p; 
250 l/p; 500 l/p; 
1 m3/p; 2.5 m3/p; 5 m3/p; 10 m3/p; 25 
m3/p; 50 m3/p; 100 m3/p; 250 m3/p; 500 
m3/p; 1000 m3/p

Preset: Depending on ordered configura‐
tion. Selection is noted on the name‐
plate. Setting is HW key locked. Note: The 
setting shall be equal to the connected 
energy calculator.

Pulse value B
(depending on DN value)

Preset: Depending on ordered configura‐
tion. Selection is noted on nameplate.
Possible presets: 0.1 l/p; 0.25 l/p; 0.5 l/p; 
1 l/p; 2.5 l/p; 10 l/p; 25 l/p; 50 l/p; 100 l/p; 
250 l/p; 500 l/p; 
1 m3/p; 2.5 m3/p; 5 m3/p; 10 m3/p; 25 
m3/p; 50 m3/p; 100 m3/p; 250 m3/p; 500 
m3/p; 1000 m3/p
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  FUS380 FUE380
Pulse width for pulse A Setting options: 5; 10; 20; 50; 100; 200; 

500 ms 
Preset: Depending on ordered configura‐
tion. Selection is noted on the name‐
plate.

Setting: Depending on ordered configu‐
ration. Selection is noted on the name‐
plate. 
Typical preset: 5 ms.
Setting is HW key locked.

Pulse width for pulse B Setting options: 5; 10; 20; 50; 100; 200; 
500 ms 
Preset: Depending on ordered configura‐
tion. Selection is noted on the name‐
plate.

Note
HW key protected parameters
For type-approved and verified FUE380 flowmeter the settings for output A are HW key protected 
and can be only read, but not changed via PDM. The HW key is located behind the display and 
is thereby protected by the display sealing. The verification sealing may only be broken with the 
acceptance of the authorities. For further details see Hardware key (Page 73).

6.6.6 Output A, terminals 56/57:
The pulse rate can be seen on transmitter side label (system nameplate).
The settings are dependig on the ordering. The following table shows the typical 
recommended pulse output settings (pulse width 5 ms) for the energy calculator SITRANS 
FUE950
For optimal benefit, the pulse value and pulse length must be selected as low as possible. 
The following calculation formula can be used for determining the lowest pulse value at a 
pulse length of 5 ms:
L/pulse > Qs (m3/h)/360
For example Qs = 300 m3/h; L/pulse > 300/360; L/pulse > 0.83; therefore the pulse value 
must be 1 l/pulse (nearest possible ordering selection). 
See also the pulse guide in PDM [Device → Pulse guide (offline)].

Table 6-5 Recommended pulse values for FUE950
DN Pulse setting (liter/pulse) with 5 ms pulse length
50 1
65 1
80 2.5
100 2.5
125 2.5
150 10
200 10
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DN Pulse setting (liter/pulse) with 5 ms pulse length
250 10
300 50
350 50
400 50
500 100
600 100
700 100
800 100
900 100
1000 100
1200 100

6.6.7 Output B, terminals 66/67:
The output B setting must be selected according to application specific requirements (default 
setting = Alarm).

Preset to alarm indication:

Example: If track 1 is not measuring, a  appears on display. Failure code F1 appears in 
display menu 4, and relay output terminals switch to Off.

Call up indication:

When output B is configured as Call-up, the output is activated by an alarm condition and 
remains on until it is manually reset via communication interface and the PDM program (or 
via manually power down of the device).
A new alarm will not activate a Call-up function if the Call-up function is still active from a 
previous alarm. 
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6.6.8 Optional current output, terminals 31/32
1. In SIMATIC PDM navigate to [Output → Option module] in the structure tree.
2. Set Selection of option module to Current output.
3. Make sure that Enable is set to Yes.

Figure 6-4 PDM Example
4. Set required parameters.
5. Click on [Download to device] icon to apply settings.

See also parameters listed in Output (Page 104).

Note
Default settings
The 4 mA always equals 0 flow rate and the 20 mA (parameter 907) equals the Qp value selected 
via the order code. The default Qp can be found on the transmitter nameplate.

Note
IrDA communication
The IrDA communication has higher priority than the communication on the output signals. 
During IrDA communication with the transmitter, the transmitter will keep measuring, but the 
signal from the current output module will show the last value received from the transmitter for 
up to 40 seconds. After that the signal will show the selected error signal (default 3.6 mA) even 
if Alarm [912] is set to Off.
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Note
Alarm signal
The alarm signal has higher priority than the Fixed flow mode enable (510) and Fixed flow value 
(511). To use this fixed flow (for example during a test where an alarm signal may appear) the 
alarm signal for current output module (912) must be disabled (set to [Off]).

Note
Power off
The settings for Fixed mode (910) and Fixed value (911) will not be reset at power off.

Note
Start-up
During system start-up the current output signal is 3.6 mA (4 mA if the output function setting 
is disabled).

6.6.9 Checking the operation readiness
All parameters are now set and defined according to the application.
1. Select: [Device → Download to device...] to download the parameters to the device.

Note
Before downloading the parameters, check that all listed data are loaded or changed and in 
accordance with the application requirements.

2. Click [Start] to download all changes from the table to the device.
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View process values   
The system is now ready for normal operation. 
1. Select [View → Process Variables] to see all measured process values.
2. Verify that the fields show the expected values.

Note
Measured Track Values
The Measured Track Values should show stable values within the normal range, i.e. the gains 
should be stable values between 3 and 12 (smaller sizes low values and larger sizes high values) 
and the actual velocities for the paths should be stable, constant and smoothly changing values 
between 0 and 10 m/s.

Store settings on the PC
Store the device settings after verifying the values. 
• Choose: [Device → Upload to PG/PC] to get all the settings.
• Store the complete settings on your PC via [File → Export].

Commissioning
6.6 Commissioning via PDM

SITRANS FUS380/FUE380
Operating Instructions, 03/2023, A5E00730100-AG 69



Commissioning
6.6 Commissioning via PDM

SITRANS FUS380/FUE380
70 Operating Instructions, 03/2023, A5E00730100-AG



Functions 7
7.1 Unit selection

The device is delivered with totalizer and flow rate units in m and m3/h, respectively, as standard. 
However, it is possible to manually configure the device to operate with other units.

Changing the units
Go via PDM menu [Device → Unit guide (offline)]. Select the new unit from the list and click on 
[Apply Change of Units]. 

Figure 7-1 Unit selection
Click on the [Download to device] icon to apply the changes.

Note
The display is only able to show m3 and m3/h

If the units are changed to units other than m3 and m3/h, the display will not show any unit 
indication after the measured value on the display. To show the new customer unit on the 
display, a sticker can be used to show units. This sticker should be affixed to the transmitter 
display.
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7.2 Number of decimal digits
For the display values (totalizers in menu 1 and 2 and flow in menu 3) Auto adjust decimal point 
is the default setting. This means that the number of digits after the decimal point automatically 
will be reduced with increasing number of digits before the decimal point.

7.3 Password-protected data
In the Modbus communication via SIMATIC PDM, the flowmeter information is protected by a 
password. The default password is "1000" and it can be changed after gaining access to the 
flowmeter or via the PDM menu [Device → Change Password (Online)]. The password can be 
changed without the use of the HW key.

Figure 7-2 Change password
Click [Write the new password to the device] and [Close].
The password protection can be disabled by going to [Device → Disable password 
protection)] and clicking on "Disable password protection".

Figure 7-3 Disable password
If you disable the password protection a dialog box will appear.

Figure 7-4 Password protection disabled
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7.4 Hardware key

Hardware (HW) key
To gain access to protected parameters of the transmitter, a hardware jumper (HW key) must be 
installed as shown below. The HW key place is located internally on the right top part of PCB 
behind the display as shown.

Note
For type-approved and verified FUE380 flowmeter the HW key is protected by a verification 
sealing on the display frame (see Sealing of FUE380). The verification sealing can only be 
opened by the user with the acceptance of the local authorities.

Figure 7-5 HW key behind the display (placed on the right pins)

Note
Important
In this mode, with the HW key installed, many parameters in PDM are opened. If these 
parameters are changed, it can seriously affect the meter accuracy and operation. Be careful 
when writing new parameters.

Changing the HW-protected parameters
1. Disconnect the power supply from the transmitter, i.e. battery plug and the mains power 

supply
2. Remove the frame and the display from the transmitter.
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3. Insert the HW key vertically on right pins as shown in figure above.
4. Remount the display and frame on transmitter.
5. Restart the device.
6. Make parameter changes through PDM.
7. Download parameter changes to the device.
8. Remove the HW key by following the preceding steps.
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Service and maintenance 8
8.1 Maintenance

The device is maintenance-free. However, a periodic inspection according to pertinent directives 
and regulations must be carried out.   
An inspection can include check of:
• Ambient conditions
• Seal integrity of the process connections, cable entries, and cover screws
• Reliability of power supply, lightning protection, and grounds

Note
Siemens defines flow sensors as non-repairable products. 

WARNING
Impermissible repair and maintenance of the device
• Repair and maintenance must be carried out by Siemens authorized personnel only.

8.2 Battery replacement

NOTICE
Battery replacement interval
- Only for devices with backup battery - 
It is recommended to replace the battery pack at the latest after 6 years.
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Battery lifetime
The battery lifetime depends on the frequency of mains supply failure. Under normal 
temperature and working conditions a battery can have an operation lifetime of up to 6 
years. 
1. Unscrew battery cover and remove old battery pack.

2. Fit new battery pack in transmitter.

8
7
H
1
3
3
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3. Connect battery. 
Ensure that wire is inserted into small channel leading from plug to battery.

4. Remount battery cover.

Note
Every time a battery is fitted and connected, the unit runs a start-up routine.
A battery replacement does not influence the transmitter settings and accumulated process 
values. 
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Resetting the internal battery counter
After replacing the batteries, reset the internal battery counter in order to indicate the power 
capacity correctly.

Note
Battery capacity
The transmitter setting for the battery capacity is pre-configured by the ordered version. To 
ensure the correct battery status calculation the replacement battery shall be the same type and 
have the specific capacity. 

8.3 Service menu
The service menu ( ) is accessible from all menus by pressing the push button for minimum 2 
seconds. To return back to the main menu you need to press the push button for a minimum of 
2 seconds again. If no action is taken you will be taken back to the main menu after 10 min if 
back-up battery powered or after 2 min if mains-powered.

Table 8-1 Service menu
Menu Parameter Display example Comments
1 Gain path 1 and path 2 Gain for path 1 and path 2 ranging 

from 0 to 15. The optimal gain val‐
ues are explained in Figure 9-2 SI‐
TRANS FUS080 Gain step vs. Sen‐
sor distance (Page 90).

2 Signal level AB and BA of 
path 1

Signal level for Downstream and 
Upstream Sensor for path 1 typical‐
ly between 230 and 380

3 Signal level AB and BA of 
path 2

Signal level for Downstream and 
Upstream Sensor for path 2 typical‐
ly between 230 and 380

4 Transition time (μs) AB 
of path 1

Time of Flight Downstream, from 
Sensor A to B for path 1

5 Transition time (μs) AB 
of path 2

Time of Flight Downstream,from 
Sensor A to B for path 2

6 Transition time (μs) BA 
of path 1

Time of Flight Upstream ,from Sen‐
sor B to A for path 1

Service and maintenance
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Menu Parameter Display example Comments
7 Transition time (μs) BA 

of path 2
Time of Flight Upstream from Sen‐
sor B to A for path 2

8 Delta time (ns) of path 1 Delta Time Of Flight for path 1, dif‐
ference between Down and up-
stream TOF
Positive value equals positive flow

9 Delta time (ns) of path 2 Delta Time Of Flight for path 2, dif‐
ference between Down and up-
stream TOF
Positive value equals positive flow

10 Velocity (m/s) path 1 Measured flow velocity for path 1

11 Velocity (m/s) path 2 Measured flow velocity for path 2

See also
Diagnosing with PDM (Page 88)

8.4 Technical support
If you have any technical questions about the device described in these Operating Instructions 
and do not find the right answers, you can contact Customer Support:     
• Via the Internet using the Support Request: 

 Support request (http://www.siemens.com/automation/support-request) 
• Via Phone:

– Europe: +49 (0)911 895 7222
– America: +1 423 262 5710
– Asia-Pacific: +86 10 6475 7575

Further information about our technical support is available on the Internet at 
 Technical support (http://support.automation.siemens.com/WW/view/en/16604318) 

Service & Support on the Internet
In addition to our documentation, we offer a comprehensive knowledge base online on the 
Internet at: 
Service and support (http://www.siemens.com/automation/service&support) 
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There you will find:
• The latest product information, FAQs, downloads, tips and tricks.
• Our newsletter, providing you with the latest information about your products.
• Our bulletin board, where users and specialists share their knowledge worldwide.
• You can find your local contact partner for Industry Automation and Drives Technologies in 

our partner database.
• Information about field service, repairs, spare parts and lots more under Services.

Additional Support   
 If you have additional questions about the device, please contact your local Siemens 
representative and offices at:
Local contact person (http://www.automation.siemens.com/partner)

8.5 Application-specific data - Qualification certificate
In case the device needs service, the technical support team will typically request information 
about the application and the flowmeter.
• Prepare a sketch of the installation/application.
• For your convenience you may create a qualification certificate via SIMATIC PDM

Service and maintenance
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1. In PDM click on [Device → Qualification Certificate]. 

2. Click on [Generate qualification certificate].

3. Click on [Close].
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The Qualification Certificate is now available via Microsoft Word. Add the required application 
information in the document (see Figure 8-1 Qualification certificate (page 1) (Page 83), 
Figure 8-2 Qualification certificate (page 2) (Page 84) and Figure 8-3 Qualification certificate 
(page 3) (Page 85)).
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Figure 8-1 Qualification certificate (page 1)
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Figure 8-2 Qualification certificate (page 2)
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Figure 8-3 Qualification certificate (page 3)

8.6 Return procedures
Enclose the delivery note, the cover note for return delivery together with the declaration of 
decontamination form on the outside of the package in a well-fastened clear document pouch.     

Service and maintenance
8.6 Return procedures

SITRANS FUS380/FUE380
Operating Instructions, 03/2023, A5E00730100-AG 85



Required forms
• Delivery Note
• Cover Note for Return Delivery with the following information

Return delivery form (http://support.automation.siemens.com/WW/view/en/16604370)
– product (ordering number)
– number of devices or spare parts returned
– reason for the return

• Declaration of Decontamination 
Decontamination declaration (http://pia.khe.siemens.com/efiles/feldg/files/Service/
declaration_of_decontamination_en.pdf)
With this declaration you certify that the returned products/spare parts have been carefully 
cleaned and are free from any residues.
If the device has been operated together with toxic, caustic, flammable or water-damaging 
products, clean the device before return by rinsing or neutralizing. Ensure that all cavities are 
free from dangerous substances. Then, double-check the device to ensure the cleaning is 
completed.
We will not service a device or spare part unless the declaration of decontamination 
confirms proper decontamination of the device or spare part. Shipments without a 
declaration of decontamination will be cleaned professionally at your expense before further 
proceeding. 

You can find the forms on the Internet and on the DVD delivered with the device.

Note
Return of products with Lithium batteries  
Lithium batteries are certified as dangerous goods according to the Regulation of Dangerous 
Goods, UN 3090 and UN 3091. Special transport documentation is required to observe these 
regulations. 
Therefore it is recommended to remove lithium batteries prior to shipment
If the battery is important for the examination of the product and it cannot be removed, the 
product has to be returned according to the Regulation of Dangerous goods.

8.7 Battery disposal
In accordance with EU directive 2006/66/EC, batteries are not to be disposed of via municipal 
waste disposal services.
Waste industrial batteries from our products are accepted back by Siemens and by the local 
Siemens representatives. Please follow the return procedures of Siemens or  talk to your local 
Siemens partner (http://www.automation.siemens.com/partner).
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Troubleshooting/FAQs 9
9.1 Error codes

A list of error codes is available in SIMATIC PDM (active errors are check-marked). Access to this 
list is gained via [Diagnostics → Device Status] in parameter 200 Fault status.. In the figure 
below, error code F 5 is active.

Figure 9-1 List of error codes shown in PDM

Table 9-1 Error codes shown in the display and in PDM 
Error 
code

Error Remedy/Cause

Blank 
display

Battery plug not connected, or battery 
empty, mains power interrupted

• Check flowmeter version. Battery version not 
able to run on mains power

• Battery empty: Replace battery pack
• Battery plug not plugged into the transmitter, 

see Battery replacement (Page 75)
F 1 Path 1 (upper path) not measuring No water in upper part of pipe and/or cables or sen‐

sor 1A or 1B defective
F 2 Path 2 (lower path) not measuring No water in lower part of pipe and/or cables or sen‐

sor 2A or 2B defective
F 3 Internal software failure Contact Siemens customer support
F 4 Internal software failure Contact Siemens customer support
F 5 Power supply warning • Mains power fails (only mains-powered versions 

with battery back-up)
• Replace battery pack (battery-powered versions 

only)
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Error 
code

Error Remedy/Cause

F 6 Flow exceeds preset flow rate in unit 
(max. speed 10 m/s)

Flowrate too high

F 7 Pulse output A overflow Pulse output exceeds 100 Hz or 50% duty cycle
F 8 Pulse output B overflow Pulse output exceeds 100 Hz or 50% duty cycle
F 9 Datalogger warning/alarm Datalogger warning monitors whether actual con‐

sumption on Totalizer 1 is on end of log interval or 
above/below the limit settings. 
The warning has no influence on the flowmetering. 
Check data logger values and consumption limit (via 
PDM parameter 602) 

Errors "F 1" to "F 4" affect the performance of the meter and the flowmeter may stop 
measuring.
Errors "F 1" and "F 2" disappear when the alarm condition is corrected.
Errors "F 5" to "F 9" are only warnings and do not affect the measurement, but they will 
influence the outputs.
The error indications disappear when the alarm conditions are corrected and a reset via the 
communication interface has been carried out.

Example
Error code "F 1 2" in the display indicates a combination of error codes "F 1" and "F 2".
Possible causes:
• Empty pipe
• Path 1 and path 2 cables defective
• Path 1 and path 2 cables not connected
• Sensors defective

9.2 Diagnosing with PDM
SIMATIC PDM is a suitable tool for diagnosing the device. You can use SIMATIC PDM to read all 
parameters available in FUS080 to a table for analyzing offline, view online/actual process values 
and online/actual diagnostic information.   

Requirements
The following procedure must be completed before diagnosing:
• Connection of Modbus interface via PC and IrDA, see also Commissioning via PDM (Page 56)
• Installation of PDM and FUS080 PDM driver, see also Installing the device driver (Page 59)
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Diagnosing with PDM
Access the device status via [Diagnostic → Device Status].

Online process values are available under menu [View → Display].

The Measured Track Values tab shows the gain steps and the flow velocities for path 1 and 
path 2. For 1-path applications the values for path 2 (track 2) are 0.
The gain steps depend on the pipe size and the conditions of the measuring media.
The flow velocities depend on the flow in the pipe.

Troubleshooting/FAQs
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① Gain step
② Gain step max
③ Gain step min
④ Sensor distance [mm]

Figure 9-2 SITRANS FUS080 Gain step vs. Sensor distance
Gain step
The graph above shows which gain step to expect for a particular sensor distance (face to 
face distance). The upper curve indicates the upper limit and the lower curve indicates the 
lower limit. 
The graph applies to perfectly aligned sensors in clean water, but takes into account the 
expected variance from the converter and the sensors. 
Gain step error conditions

Condition Cause
15 • No sensor (e.g. defective cable)

• Empty pipe
High values • High damping (e.g. inhomogeneous media)

• Unsuitable medium
• Path angular misalignment

Unstable/fluctuating values • Air bubbles or solids in medium
• Bad inlet conditions

Δ gain step between path 1 and path 2 > 1
(2-path systems only)

• Bad inlet conditions
• Inhomogeneous medium
• Path angular misalignment
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In case of angular misalignment between sensor faces, the gain step will increase as shown 
in the table below:

Angular misalignment Gain step increase
2° 1
3° 2
4° 3
5° 5

Flow velocity error conditions

Condition Cause
Δ flow velocity values (between path 1 and path 2) 
> 1
(2-path systems only)

• Bad inlet conditions (the higher the delta, the 
worse the inlet conditions)

• Disturbances in the pipe (bad flow profile)
Unstable/fluctuating values • Air bubbles or solids in media

• Bad inlet conditions

The actual velocities for the paths should be stable, constant and smoothly changing values 
between 0 and 10 m/s.
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Technical specifications 10
10.1 Accuracy

Typical accuracy SITRANS FUS380:

Figure 10-1 Accuracy SITRANS FUS380
± 0.5 % for 0.5 m/s < v < 10 m/s and ± 0.25 Νact. [%] below 0.5 m/s

Typical accuracy SITRANS FUE380:

① FUE380 - Admissible limits according to EN 1434 class 2 and OIML R 75 class 2
Figure 10-2 Accuracy SITRANS FUE380
± (0.5 +0.02 Qp/Q) [%]
Qp according to EN 1434/OIML requirements
SITRANS FUE380 fulfills the requirements:
Εf = ± (2 + 0.02 Qp/Q) max. ± 5 %, according to EN 1434 and OIML R 75, class 2 or MID class 2 
requirements
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Example: DN100, Qp = 60m3/h and Q = 1.2 m3/h
Εf = ± (2 + 0.02 Qp/Q) = ± (2 + 0.02 (60/1.2)) = ± (2 + 1) = ± 3%

10.2 FUS380 and FUE380 systems
Table 10-1 Technical data SITRANS FUS380 and FUE380
Description Specification
Enclosure design/mate‐
rial 

Fiber glass reinforced polyamide in light-gray color

Enclosure IP67 according to EN 60529 and DIN 40050 (NEMA 4X/6)
Wall mounting kit Terminal box made of fiber glass reinforced polyamide in light-gray color with 

cable glands and a stainless steel bracket for wall or pipe mounting
Cable glands In wall mounting kit:

3 x M20 PA plastic cable glands (1 for mains power supply cable, and 2 for 
output cables)

Ambient temperature • MID version: -10 °C to +55 °C (14 °F to 131 °F)
• Non-MID version: -10 °C to +60 °C (14 °F to 140 °F)

Storage temperature −40 °C to + 85 °C (−40 °F to +185 °F) 
Sensor cables Coaxial cable, impedance 75 Ohm, ∅ app. 6 mm
Connection cable Cable length:

Max. 30 meter between transmitter and sensor terminal box
(5 m (16.4 ft), 10 m (32.8 ft), 20 m (65.6 ft), or 30 m (98.4 ft) available)

Mechanical vibration 2 g, 1 to 800 Hz sinusoidal in all directions according to IEC 68-2-6 
Power supply Battery 1): 

• Replaceable 3.6 V LiSOCl (Lithium Thionyl Chloride)
• Double battery pack 33 Ah or single back-up battery 16.5 Ah;
• Battery change interval: 4.2 / 6 years at 60 °C (140 °F) operation
Mains: 
• 115 to 230 V AC (50 to 60 Hz) with voltage fluctuations -25% / +15%: 87 

to 230 V AC, power: 2.5 VA
Display • LCD, 8 digits, additional 2 digits and symbols for status information

• Units: Volume unit: m3 (default display unit), Flow unit: m3/h (default dis‐
play unit)

• Alarm codes (F 1 to F 9) for: path 1 or 2 not measuring, internal failure, 
power supply failure, flow overload, pulse output frequency overload, data 
logger warning

Push button One push button for toggling between display information 
Measuring function • 0.5 Hz battery mode

or 
• 15 Hz mains-powered

Communication IrDA on display panel (Modbus RTU protocol)
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Description Specification
Outputs (standard) • Two passive, galvanically isolated open drain-mos outputs (output A and B)

• Max. ±35 V, 50 mA
• Output A: Preset to pulse output for forward flow (default: 100 l/pulse)
• Output B: Preset to alarm for present failure
• Pulse with: 5, 10, 20, 50, 100, 200, 500 ms (default: 5 ms)
• Max. pulse frequency: 100 Hz at Qmax setting (105% of Qs)

EMC EN/IEC 61326-1 (Industry) 
Transmitter weight 1.5 kg (3 lb) 

1) Waste industrial batteries are accepted back by Siemens or by the local Siemens 
representative. Please talk to your local Siemens contact or follow the return procedures 
of Siemens Flow Instruments.

Table 10-2 Pulse output / Cable specification
Description Specification
Outer diameter 6 to 12 mm (0.24" to 0.47")
Number of wires Min. two
Wire size 0.2 to 1.5 mm2

Cable type Single shielded
Temperature
 

Ambient: -20 to +60 °C (-4 to +140 °F)
Storage: -40 to +85 °C (-40 to +185 °F)

Mechanical environ‐
mental conditions

Impact resistance:
IK06 acc. to IEC 62262

No insulation is required for the Pulse output circuit.

10.3 Optional current output module
Table 10-3 Technical data for optional current output module
Description Specification
Type Passive current output
Output range 4 to 20 mA

(4 mA: Represents no flow; 
20 mA scaling: Assigned to Qp, defined by oder code
20 mA scaling range can be between cut off and Qmax)
Flow functions up to 20.5 mA, in the range of 3.6 mA to 22.6 mA

Alarm limit 3.6 mA or 22.6 mA
(Default setting: 3.6 mA)

Accuracy  0.1 % of full scale, drift 50 ppm/K
Dimensions L x W x H:

78 x 43 x 15 mm (3.07" x 1.69" x 0.59")

Technical specifications
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Description Specification
Ambient temperature Operation: -20 to +60 °C (-4 to +140 °F)

Storage: -40 to +85 °C (-40 to +185 °F)
Power supply Passive module

External supply voltage: 8.5 to 36 VDC
Max. load Rmax = (U ext. supply – 8.5 V) / 25 mA
Update time < 0.3 seconds
Output stabilization 90 % within 0.2 seconds
Initialization value 3.6 mA (output value during system start up when the current output module 

is enabled)
Fixed value 4 mA (output value when the current output module is disabled)
Galvanic isolation Yes

Table 10-4 Requirements for current output cable
Description Specification
Outer diameter 6 to 12 mm (0.24" to 0.47")
Number of wires Min. two
Wire size 0.2 to 1.5 mm2

Cable type Single shielded
Temperature
 

Ambient: -20 to +60 °C (-4 to +140 °F)
Storage: -40 to +85 °C (-40 to +185 °F)

Technical specifications
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10.4 Output characteristics

Current output

100%-100%

① Upper alarm limit
② Upper current limit
③ Upper current scaling point
④ Lower current scaling point
⑤ Lower alarm limit

Figure 10-3 Bidirectional flow

100%-100%

① Upper alarm limit
② Upper current limit
③ Upper current scaling point
④ Lower current scaling point
⑤ Lower alarm limit

Figure 10-4 Positive flow
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① Upper alarm limit
② Upper current limit
③ Upper current scaling point
④ Lower current scaling point
⑤ Lower alarm limit

Figure 10-5 Negative flow

10.5 Battery
Table 10-5 Battery types
Description Specifications
Main battery
(for battery-powered 
versions)

Replaceable 3.6 V LiSOCl (Lithium Thionyl Chloride) dual battery pack 34 Ah of 
two D-cell types

Back-up battery
(for mains-powered ver‐
sions)

Single battery 17 Ah of one D-cell type

Note
The batteries are not rechargeable; they should be replaced after maximum 6 years.   

Consumption and battery operation time calculation
For battery versions, the battery operation time depends on the connected battery pack as 
well as the operation conditions of device. 
Every 5 minutes the advanced power management system of the transmitter calculates the 
battery consumption and the remaining battery operation time.
For battery versions, only the internal battery pack has a nominal capacity of 34 Ah giving a 
typical operation time up to 6 years in a revenue application.
The ambient temperature of the transmitter also influences the battery capacity.

Technical specifications
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The typical operation time up to 6 years is based on only 80% battery capacity, low pulse 
output frequency, seldom use of communication and an operation time/temperature profile 
of 5% at 0 °C (32 °F), 80% at 15 °C (59 °F) and 15% at 50 °C (122 °F).
The effect of other temperatures is shown in the figure below.
A variation in temperature from 15 °C to 55 °C (59 °F to 131 °F) reduces the capacity by 17% 
(in the figure from 15 Ah to 12½ Ah).

Note
The installation orientation of the battery pack may influence the battery capacity. Optimal 
battery capacity is achieved with the battery pack in an upright position.

10.6 Sensor for FUS380 and FUE380
Table 10-6 Technical data
Description Specification
Pipe design 2-track sensor with flanges and integrated sensors wet-calibrated from factory
Nominal size DN 50, 65, 80, 100, 125, 150, 200, 250, 300, 350, 400, 500, 600, 700, 800, 

900, 1000, 1200
Pressure rate PN 16, PN 25, PN 40

EN 1092-1 flanges:
• type 01: DN 100 to DN 125
• type 11: DN 150 to DN 1200
• type 11 'design': DN 50 to DN 80

Pipe materials • DN 100 to 1200: Carbon Steel EN 1.0345 / p235 GH, painted in light gray
• DN 50 to DN 80: Die-cast bronze G-CuAn 10/W2.1050.01 (EN1982)

Sensor design • DN 100 to 1200: Integrated version and welded onto the pipe
• DN 50 to 80: Screwed into the pipe

Sensor material Stainless steel (AISI 316 / 1.4404) / brass (CuZn36Pb2As)
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Description Specification
Medium temperature DN 100 to 1200: 

• Remote: 2 to 200 °C (35.6 to 392 °F) 1)

DN 50 to 80: 
• Remote: 2 to 150 °C (35.6 to 302 °F) 1)

DN 50 to 1200:
• Compact: 2 to 120 °C (35.6 to 248 °F) 1)

Measured media Heating water, according to VDI-2035 (pH 8.2 - 10.5), industrial VdTÜV infor‐
mation sheet 1466 and AGFW information sheet FW 510

1) MID: minimum temperature 15 °C (59 °F)

10.7 Dimensional drawings for FUS380 and FUE380

Transmitter IP67/NEMA 4X/6, wall mounting

10.8 Sensor dimensions for FUS380 and FUE 380
Size PN 16 PN 25 PN 40        
  L Weight L Weight L Weight Material A1 A2 Lift

hugDN mm kg mm kg mm kg   mm mm
50 -     - 300 +0/-2 10 Bronze 350 196 No
65 -     - 300 +0/-2 15 Bronze 363 206 No
80 -     - 350 +0/-2 18 Bronze 370 216 No
100 350 +0/-2 15   - 350 +0/-2 18 Steel 372 221 No
125 350 +0/-2 18     350 +0/-2 24 Steel 385 226 No
150 500 +0/-3 28     500 +0/-3 34 Steel 399 236 No
200 500 +0/-3 38 500 +0/-3 47 500 +0/-3 55 Steel 425 260 Yes
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Size PN 16 PN 25 PN 40        
  L Weight L Weight L Weight Material A1 A2 Lift

hugDN mm kg mm kg mm kg   mm mm
250 600 +0/-3 60 600 +0/-3 76 600 +0/-3 91 Steel 452 286 Yes
300 500 +0/-3 66 500 +0/-3 81 - - Steel 478 312 Yes
350 550 +0/-3 94 550 +0/-3 121 - - Steel 495 341 Yes
400 600 +0/-3 124 600 +0/-3 153 - - Steel 520 353 Yes
500 625 +0/-3 194 625 +0/-3 231 - - Steel 570 404 Yes
600 750 +0/-3 303 750 +0/-3 365 - - Steel 622 455 Yes
700 875 +0/-3 361 875 +0/-3 565 - - Steel 673 506 Yes
800 1000 +0/-3 494 1000 +0/-3 770 - - Steel 724 556 Yes
900 1230 +0/-6 535 1300 +0/-6 835 -   Steel 775 606 Yes
1000 1300 +0/-6 594 1370 +0/-6 1078 - - Steel 826 656 Yes
1200 1360 +0/-6 732 -   -   Steel 928 756 Yes

Size PN 16 PN 25 PN 40        
  L Weight L Weight L Weight Material A1 A2 Lift

huginch inch lb inch lb inch lb   inch inch
2 - - - - 11.81 

+0/-0.08
22 Bronze 13.78 7.72 No

2 1/2 - - - - 11.81 
+0/-0.08

33 Bronze 14.30 8.11 No

3 - - - - 13.78 
+0/-0.08

40 Bronze 14.57 8.50 No

4 13.78 
+0/-0.08

33 - - 13.78 
+0/-0.08

40 Steel 14.65 8.70 No

5 13.78 
+0/-0.08

40 - - 13.78 
+0/-0.08

53 Steel 15.16 8.90 No

6 19.68 
+0/-0.12

62 - - 19.68 
+0/-0.08

75 Steel 15.71 9.29 No

8 19.68 
+0/-0.12

84 19.68 
+0/-0.12

104 19.68 
+0/-0.12

121 Steel 16.74 10.24 Yes

10 23.62 
+0/-0.12

132 23.62 
+0/-0.12

168 23.62 
+0/-0.12

201 Steel 17.80 11.26 Yes

12 19.68 
+0/-0.12

146 19.68 
+0/-0.12

179 - - Steel 18.82 12.28 Yes

14 21.65 
+0/-0.12

207 21.65 
+0/-0.12

267 - - Steel 19.49 13.43 Yes

16 23.62 
+0/-0.12

273 23.62 
+0/-0.12

337 - - Steel 20.48 13.90 Yes

20 24.61 
+0/-0.12

428 24.61 
+0/-0.12

509 - - Steel 22.45 15.91 Yes

24 29.53 
+0/-0.12

668 29.53 
+0/-0.12

805 - - Steel 24.49 17.91 Yes
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Size PN 16 PN 25 PN 40        
  L Weight L Weight L Weight Material A1 A2 Lift

huginch inch lb inch lb inch lb   inch inch
28 34.45 

+0/-0.12
796 34.45 

+0/-0.12
1246 - - Steel 26.50 19.92 Yes

32 39.37 
+0/-0.12

1089 39.37 
+0/-0.12

1698 - - Steel 28.51 21.89 Yes

36 48.43 
+0/-0.24

1179 51.18 
+0/-0.24

1841 -   Steel 30.52 23.86 Yes

40 51.18 
+0/-0.24

1310 53.94 
+0/-0.24

2205 - - Steel 32.52 25.83 Yes

48 53.54 
+0/-0.24

1614 -   -   Steel 36.54 29.76 Yes

Weight for transmitter/electronics 1.5 kg (3.3 lb) (compact version) or approximately 5 kg (11 
lb) (remote version including 10 m (32.8 ft) cable set).
For flange values - see norm EN 1092-1.
- means not available.
All weights are approximate. 

Technical specifications
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Parameter lists A
The following tables show the various parameters available via PDM.
The parameters are accessible at three different levels:
• Read: Maintenance level
• Read/Write (R/W): Specialist level (write access is only permitted after entering the user 

password; default password is 1000)
• Hardware locked (HW key): The parameter is only accessible when a HW key is mounted

Note
For type-approved and verified FUE380 flowmeter the settings are HW key protected and 
therefore read only. This HW key is protected via the verification sealing. The verification sealing 
can only be opened by the user with the acceptance of the local authorities.

A.1 Identification
Table A-1 Identification parameters (FW 2.04 and EDD 1.02.09-08)   
Parameter Default val‐

ue 
Value range Access 

level
Description

1 Application identifier Identity   R/W Customer application identification informa‐
tion (max 16 characters)

2 Application location Location   R/W Customer application location information 
(max 16 characters)

Device
5 Sensor size Product de‐

pendent
  R/W Pipe diameter of the sensor. It is only a text 

field for measurement system information. 
The value has no influence on the measure‐
ment. Please see inner diameter at pipe date 
in parameter 306

8 Totalizer unit m3 See Table A-6 To‐
talizer units 
(Page 114)

R/W Totalizer unit as text for volume. Change the 
unit in parameter table if the device menu 
"Unit guide (offline)" does not list the wanted 
unit.
Note: The device display can show "m3" unit 
only - other units cannot be shown on the 
display, but will be used and shown online 
via PDM
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Parameter Default val‐
ue 

Value range Access 
level

Description

9 Flow unit m3/h See Table A-7 
Flow rate units 
(Page 115)

R/W Flow unit as text for actual flowrate. Change 
the unit in parameter table if the device 
menu "Unit guide (offline)" does not list the 
wanted unit.
Note: The device display can show "m3/s" 
unit only - other units cannot be shown on 
the display, but will be used and shown on‐
line via PDM.

10 Maximum flow Qmax 1000000 m3/h R/W Maximum flow
20 Vendor name Siemens AG   Read Siemens AG Flow Instruments, Germany
21 Module type Product de‐

pendent
• FUE380
• FUS380

Read Type of flowmeter, depending on ordered 
system

22 Software version 2.03   Read Software version of the flowmeter
23 Product code number Product de‐

pendent
  Read Siemens production sales code number (the 

first part of the system number on the name‐
plate)

24 System Serial number Product de‐
pendent

  R/W Siemens production number (the s econd 
part of the system number on the nameplate

25 Transmitter serial num‐
ber

Product de‐
pendent

  HW key Serial number of the electronics

26 Sensor serial number Product de‐
pendent

  Read Serial number of the sensor

A.2 Output
Table A-2 Output parameters 
Parameter Default val‐

ue 
Value range Access 

level
Description

100 Actual date and time Product de‐
pendent

  R/W Actual date and time (day-month-year 
and hours:minutes:seconds)

101 Totalizer 1 0 -2000000001 to 
+2000000001

Read Volume for totalization register 1

102 Totalizer 2 0 -2000000001 to 
+2000000001

Read Volume for totalization register 2

103 Customer totalizer 3 0   Read Customer totalizer 3 based on totalizer 1 
set up

104 Reset customer totalizer 3 No No, Yes R/W Reset of customer totalizer
105 Customer totalizer 3 reset date Last reset 

date
dd-mm-yyyy, 
hh:mm:ss

Read Date and time when customer totalizer 
has been reset

106 Flow rate     Read Actual flow value
107 Relative flow 0   Read Actual flow value in relation to Qmax
108 Actual flow velocity for path 1 0   Read The actual flow velocity for path 1 in m/s 

(SI-unit)
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Parameter Default val‐
ue 

Value range Access 
level

Description

109 Actual flow velocity for path 2 0   Read The actual flow velocity for path 2 in m/s 
(SI-unit). 
Valid for 2-path solutions only

110 Path 1 gain step 15 1 to 15 Read Amplifier setting when measuring path 1
111 Path 2 gain step 15 1 to 15 Read Amplifier setting when measuring path 2. 

Valid for 2-path solutions only
Pulse A B
430 Output A enable Product de‐

pendent
No, Yes R/W Select "Yes" to enable output A

431 Pulse A direction Forward Forward, Re‐
verse, Forward 
net, Reverse net

R/W Pulse output calculation on pure forward 
flow or pure reverse flow - or net flow for 
forward and reverse pulse flow. 
Valid if pulse output A is enabled

432 Amount per pulse A Product de‐
pendent

0.000001 to 
1000000000

R/W Volume per pulse and selected unit 
Valid if pulse output A is enabled.

433 Pulse width for pulse A Product de‐
pendent

5, 10, 20, 50, 
100, 200, 500 
ms

R/W Pulse length when the pulse is active. 
Valid if pulse output A is enabled

440 Output B enable Product de‐
pendent

No, Yes R/W Select "Yes" to enable output B

441 Pulse B function Product de‐
pendent

Pulse, Alarm, 
Call up

R/W Configuration of output B as pulse - alarm 
or call up function. 
Valid if pulse output B is enabled

442 Pulse B direction Reverse Forward, Re‐
verse, Forward 
net, Reverse net.

R/W Pulse output calculation on pure forward 
flow or pure reverse flow - or net flow for 
forward and reverse pulse flow. 
Valid if pulse output B is enabled and pulse 
function selected

443 Amount per pulse B Product de‐
pendent

0.000001 to 
1000000000

R/W Volume per pulse. 
Valid if pulse output B is enabled and pulse 
function selected

444 Pulse width for pulse B Product de‐
pendent

5, 10, 20, 50, 
100, 200, 500 
ms

R/W Pulse length when the pulse is active. 
Valid if pulse output B is enabled and pulse 
function selected

Communication
For editing the communication settings, use PDM device menu "Communication Setting"
591 Device Communication Ad‐

dress
1 1 to 247 Read Meter has default address value 1 with se‐

lectable address up to 247
592 Baud rate 4 0 to 5 Read Communication port speed
593 Parity 0 0 to 3 Read Communication port parity
594 Interframe space 35 35 to 255 Read Minimum space between two messages 

(bytes x 10)
595 Response delay 5 1 to 50 Read Minimum time from receiving a request to 

its response
Data logger
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A.2 Output

SITRANS FUS380/FUE380
Operating Instructions, 03/2023, A5E00730100-AG 105



Parameter Default val‐
ue 

Value range Access 
level

Description

600 Log interval Monthly Daily, Weekly, 
Monthly

R/W Log interval

601 Day of week, if weekly log Sunday Monday to Sun‐
day

R/W When log interval is set to weekly logging, 
this parameter defines what weekday the 
logging is performed. 
Valid if weekly log interval is activated

602 Limit for too high consumption 1E+09 -3.4E+38 to 
+3.4E+38

R/W Limit for too high consumption during 
current log interval. Based on totalizer 1 
and the selected unit 

603 Limit for too low consumption -1E+09 -3.4E+38 to 
+3.4E+38

R/W Limit for too low consumption during cur‐
rent log interval. Based on totalizer 1 and 
the selected unit

604 Reset log No No, Yes HW key Reset data logger
610 Date of latest log period 1/1/2000 

12:00:00 
AM

  Read  

611 Latest Log period totalized (1) 0.000000   Read  
612 Latest Log period totalized (2) 0.000000   Read  
613 Latest Log period fault status no faults   Read  
614 Latest Log period status infor‐

mation
no flags   Read  

… … … … … …
735 Date of log period 26 1/1/2000 

12:00:00 
AM

  Read  

736 Log period 26 totalized (1) 0.000000   Read  
737 Log period 26 totalized (2) 0.000000   Read  
738 Log period 26 fault status no faults   Read  
739 Log period 26 status informa‐

tion
no flags   Read  

Periodic log Totalizer 1
160 Next setting date 01-01-2000 dd-mm-yyyy R/W Next setting date where actual value of 

totalizer 1 is stored
161 Latest setting date 01-01-2000 dd-mm-yyyy Read Latest setting date where value of totalizer 

1 was stored
162 Latest totalizer 1 value 0   Read Latest stored value of totalizer 1
163 Previous setting date 01-01-2000 dd-mm-yyyy Read Previous setting date where value of total‐

izer 1 was stored
164 Previous totalizer 1 value 0 dd-mm-yyyy Read Previously stored value of totalizer 1
Option module
900 Selection of option module None None, Current 

output
R/W Selction of output module type

905 SW version     Read SW version of the module
906 Enable Yes No, Yes R/W Turn on/off current output
907 Scaling Qp Cut-off to Qmax R/W Scaling flow to 20 mA
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Parameter Default val‐
ue 

Value range Access 
level

Description

908 Direction Positive Positive, Nega‐
tive, Bidirection‐
al

R/W Selection of flow direction for 4-20mA

910 Fixed mode No No, Yes R/W Turn on/off fixed current
911 Fixed value 4 3 to 24 mA R/W Fixed current value on output
912 Alarm level 3.6 mA Off, 3.6 mA, 

22.6 mA
R/W Selection of alarm level on current out in 

case of alarm

A.3 Diagnostics
Table A-3 Diagnostic   
Parameter Default val‐

ue
Value 
range   

Access 
level

Description

Diagnostic
500 Latest service date 01-01-2000 dd-mm-

yyyy
R/W* Latest service date (can also be used for date 

of installation)
501 Operating time 0 3.4E+38 h Read Total operation hours since last power up
503 Number of startups 0 0 to 65535 Read Total number of power-ups since first power-

up.
Alarm
200 Fault status   One or 

more of the 
following 
values: 1, 2, 
3, 4, ... up 
to 16

Read Fault status
1: Path 1 error
2: Path 2 error
3: Dual slope calibration error
4: Database checksum error
5: Low power warning
6: Flow overload warning
7: Pulse A overload warning
8: Pulse B overload warning
9: Consumption interval error
10: Leakage error (not used)
11: Hardware calibration error
12: Not used
13: Not used
14: Not used
15: Not used
16: Not used

202 Date of fault log reset Last reset 
date

dd-mm-
yyyy, 
hh:mm:ss

Read Date of last fault log reset

204 Reset the fault log and faults No No, Yes R/W Reset the fault log and faults
205 Call up acknowledge No No, Yes R/W Select "Yes" to reset active call-up
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Parameter Default val‐
ue

Value 
range   

Access 
level

Description

209 Reset consumption log fault No No, Yes R/W Reset the consumption fault. 
Caused by too low or too high consumption in 
the log interval

210 Path 1 alarm output enable Yes No, Yes R/W Select "Yes" to enable current alarm on alarm 
output / call-up

211 Path 1 fault hours e.g. 36 h Read; Read Total hours fault active
212 Path 1 fault counter e.g. 4 0 to 65535 Read Total number of faults. 

Valid only if alarm is enabled
213 Path 1 fault appears Last fault 

appear date
dd-mm-
yyyy, 
hh:mm:ss

Read Last time the fault appeared. 
Valid only if alarm is enabled

214 Path 1 fault disappears Last fault 
disappear 
date

dd-mm-
yyyy, 
hh:mm:ss

Read Last time the fault disappeared. 
Valid only if alarm is enabled

215 Path 2 alarm output enable Yes No, Yes R/W Select "Yes" to enable active alarm on alarm 
output / call-up. 
Valid only for 2-path solutions

216 Path 2 fault hours e.g. 36 h Read; Read Total hours fault active. 
Valid only for 2-path solutions and if alarm is 
enabled

217 Path 2 fault counter e.g. 4 0 to 65535 Read Total number of faults. 
Valid only for 2-path solutions and if alarm is 
enabled

218 Path 2 fault appears Last fault 
appear date

dd-mm-
yyyy, 
hh:mm:ss

Read First time the fault appeared. 
Valid only for 2-path solutions and if alarm is 
enabled

219 Path 2 fault disappears Last fault 
disappear 
date

dd-mm-
yyyy, 
hh:mm:ss

Read Last time the fault disappeared. 
Valid only for 2-path solutions and if alarm is 
enabled

220 Dual slope alarm output en‐
able

Yes No, Yes R/W Select "Yes" to enable active alarm on alarm 
output / call-up

221 Dual slope fault hours e.g. 0 h 0 to 65535 Read Total hours fault active. 
Valid only if alarm is enabled

222 Dual slope fault counter e.g. 0 0 to 65535 Read Total number of faults. 
Valid only if alarm is enabled

223 Dual slope fault appears Last fault 
appear date

dd-mm-
yyyy, 
hh:mm:ss

Read First time the fault appeared. 
Valid only if alarm is enabled

224 Dual slope fault disappears Last fault 
disappear 
date

dd-mm-
yyyy, 
hh:mm:ss

Read Last time the fault disappeared. 
Valid only if alarm is enabled

225 Parameter checksum alarm 
output enable

Yes No, Yes R/W Select "Yes" to enable active alarm on alarm 
output / call-up

226 Parameter checksum fault 
hours

e.g. 0 h 0 ... 65535 Read Total hours fault active. 
Valid only if alarm is enabled
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Parameter Default val‐
ue

Value 
range   

Access 
level

Description

227 Parameter checksum fault 
counter

e.g. 0 0 ... 65535 Read Total number of faults. Valid only if alarm is 
enabled

228 Parameter checksum fault 
appears

Last fault 
appear date

dd-mm-
yyyy,
hh:mm:ss

Read First time the fault appeared. 
Valid only if alarm is enabled

229 Parameter checksum fault 
disappears

Last fault 
disappear 
date

dd-mm-
yyyy,
hh:mm:ss

Read Last time the fault disappeared. 
Valid only if alarm is enabled

230 Low power alarm output en‐
able

Yes No, Yes R/W Select "Yes" to enable active alarm on alarm 
output / call-up

231 Low power fault hours e.g. 0 h 0 to 65535 Read Total hours fault active.
Valid only if alarm is enabled

232 Low power fault counter e.g. 0 0 to 65535 Read Total number of faults. 
Valid only if alarm is enabled

233 Low power fault appears Last fault 
appear date

dd-mm-
yyyy,
hh:mm:ss

Read First time the fault appeared. 
Valid only if alarm is enabled

234 Low power fault disappears Last fault 
disappear 
date

dd-mm-
yyyy,
hh:mm:ss

Read Last time the fault disappeared. 
Valid only if alarm is enabled

235 Flow overflow alarm output 
enable

Yes No, Yes R/W Select "Yes" to enable active alarm on alarm 
output / call-up

236 Overflow fault hours e.g. 0 h 0 to 65535 Read Total hours fault active.
Valid only if alarm is enabled

237 Overflow fault counter e.g. 0 0 to 65535 Read Total number of faults. 
Valid only if alarm is enabled

238 Overflow fault appears Last fault 
appear date

dd-mm-
yyyy, 
hh:mm:ss

Read First time the fault appeared. 
Valid only if alarm is enabled

239 Overflow fault disappears Last fault 
disappear 
date

dd-mm-
yyyy, 
hh:mm:ss

Read Last time the fault disappeared. 
Valid only if alarm is enabled

240 Pulse A overload alarm out‐
put enable

Yes No, Yes R/W Select "Yes" to enable active alarm on alarm 
output / call-up

241 Pulse A overload fault hours e.g. 0 h 0 to 65535 Read Total hours fault active. 
Valid only if alarm is enabled

242 Pulse A overload fault coun‐
ter

e.g. 0 0 to 65535 Read Total number of faults. 
Valid only if alarm is enabled

243 Pulse A overload fault ap‐
pears

Last fault 
appear date

dd-mm-
yyyy, 
hh:mm:ss

Read First time the fault appeared. 
Valid only if alarm is enabled

244 Pulse A overload fault disap‐
pears

Last fault 
disappear 
date

dd-mm-
yyyy, 
hh:mm:ss

Read Last time the fault disappeared. 
Valid only if alarm is enabled

245 Pulse B overload alarm out‐
put enable

Yes No, Yes R/W Select "Yes" to enable active alarm on alarm 
output / call-up
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Parameter Default val‐
ue

Value 
range   

Access 
level

Description

246 Pulse B overload fault hours e.g. 0 h 0 to 65535 Read Total hours fault active. 
Valid only if alarm is enabled

247 Pulse B overload fault coun‐
ter

e.g. 0 0 to 65535 Read Total number of faults. 
Valid only if alarm is enabled

248 Pulse B overload fault ap‐
pears

Last fault 
appear date

dd-mm-
yyyy, 
hh:mm:ss

Read First time the fault appeared. 
Valid only if alarm is enabled

249 Pulse B overload fault disap‐
pears

Last fault 
disappear 
date

dd-mm-
yyyy, 
hh:mm:ss

Read Last time the fault disappeared. 
Valid only if alarm is enabled

250 Consumption alarm output 
enable

Yes No, Yes R/W Select "Yes" to enable active alarm on alarm 
output / call-up

251 Consumption fault hours e.g. 0 h 0 to 65535 Read Total hours fault active. 
Valid only if alarm is enabled

252 Consumption fault counter e.g. 0 0 to 65535 Read Total number of faults. 
Valid only if alarm is enabled

253 Consumption fault appears Last fault 
appear date

dd-mm-
yyyy, 
hh:mm:ss

Read First time the fault appeared. 
Valid only if alarm is enabled

254 Consumption fault disap‐
pears

Last fault 
disappear 
date

dd-mm-
yyyy, 
hh:mm:ss

Read Last time the fault disappeared. 
Valid only if alarm is enabled

255 Leakage alarm output enable Yes No, Yes R/W Select "Yes" to enable active alarm on alarm 
output / call-up

256 Leakage fault hours e.g. 0 h 0 to 65535 Read Total hours fault active. 
Valid only if alarm is enabled

257 Leakage fault counter e.g. 0 0 to 65535 Read Total number of faults. 
Valid only if alarm is enabled

258 Leakage fault appears Last fault 
appear date

dd-mm-
yyyy, 
hh:mm:ss

Read First time the fault appeared. 
Valid only if alarm is enabled

259 Leakage fault disappears Last fault 
disappear 
date

dd-mm-
yyyy, 
hh:mm:ss

Read Last time the fault disappeared. 
Valid only if alarm is enabled

260 Empty pipe alarm output en‐
able

Yes No, Yes R/W Select "Yes" to enable active alarm on alarm 
output / call-up

261 Empty pipe fault timer e.g. 0 h 0 to 65535 Read Total hours fault active. 
Valid only if alarm is enabled

262 Empty pipe fault counter e.g. 0 0 to 65535 Read Total number of faults. 
Valid only if alarm is enabled

263 Empty pipe fault appears Last fault 
appear date

dd-mm-
yyyy, 
hh:mm:ss

Read First time the fault appeared. 
Valid only if alarm is enabled

264 Empty pipe fault disappears Last fault 
disappear 
date

dd-mm-
yyyy, 
hh:mm:ss

Read Last time the fault disappeared. 
Valid only if alarm is enabled
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Parameter Default val‐
ue

Value 
range   

Access 
level

Description

Service
510 Fixed flow mode enable Yes No, Yes R/W Select "Yes" to force the device to show a fixed 

flow value
Default must be "No"
Always manually reset the value to "No"

511 Fixed flow value 0 -1E+09 to 
1E+09

R/W Fixed flow value for enabled fixed flow 

515 Controlling output A and B Auto Auto, 
Forced

HW key Control of output A and B is used to stop or 
force the output A and/or B.
For editing, use device menu "Service". 
Valid if pulse output is enabled

Power
130 Consumed battery capacity e.g. 

2.054239 
Ah

  Read The amount of energy consumed since last 
time the battery was replaced. 
Valid only for battery-powered versions

501 Operating hours since pow‐
er up

1105 h 3.4 E+38 Read Total operation hours since first power up

503 Numbers of power up e.g. 4 0 to 65535 Read Total number of power-ups since first power-
up.

540 Battery change enable No No, Yes R/W Select "Yes" to set battery installation date to 
current date and reset remaining battery op‐
eration capacity to maximum. 
Valid only for battery-powered versions

541 Battery installation date last battery 
installation 
date

dd-mm-
yyyy; 
hh:mm:ss

Read Latest installation date of batteries. 
Valid only for battery-powered versions

542 Power supply mode Product de‐
pendent

Battery on‐
ly, Mains on‐
ly, Mains 
with back‐
up battery.

Read The flowmeter is either powered by battery 
only, mains only or by mains with battery 
backup.
The type is defined by the order code and can‐
not be changed.

543 Actual battery capacity Product de‐
pendent

0 to 50 R/W** The capacity of the battery in Ah
- Single 16.5 Ah
- Dual battery pack 33.0 Ah
Valid only for battery-powered versions

544 Battery alarm limit 80 0 to 90 R/W Present an alarm when the consumed energy 
superceeds this percentage of the battery ca‐
pacity. 
Valid only for battery-powered versions

* Not supported for FUS080

** Maintenance = Read only
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A.4 Meter setup
Table A-4 Meter setup parameters   
Parameter Default val‐

ue 
Value 
range

Access 
level

Description

Meter Setup
307 Flow velocity offset 0 m/s -10 to 10 

m/s
HW key Velocity added to measured flow velocity

310 Calibration factor 1.0 0 to 2 R/W This calibration factor will be calculated at the 
factory with wet-calibration.
For FUS080-SONOKIT (retrofit) installations 
this parameter should be calculated by the 
pipe geometric tool (see "Pipe geo. assistant" 
in "Device" menu)

311 Adjustment Factor 1 - 2 to 2 R/W Meter correction factor for customer adjust‐
ment of the calculated flow value. Can be 
used at installations where a reference meter 
is used to get reference to the true flow rate

312 Sensor cable length Product de‐
pendent

0 to 200 m R/W Cable length (m) from sensor to transmitter

372 Filter time constant Product de‐
pendent

0 to 100 s R/W General time filter for flow measurement. Fil‐
ter constant is the time that must pass before 
the filter's ouput value is at 70% of the change 
of its input value. Higher number gives a 
slower and more stable flow signal. 

373 Low flow cut-off Product de‐
pendent

0 to 10 R/W If the flow comes below this percentage of 
Qmax, then the flow value is set to zero

374 Creep lock max number 10 0 to 20 R/W Alternative cut-off for totalizing and pulsing.
If the totalized flow within this number (N) of 
samples exceeds [(N x Qmax x low flow cut 
off)/100], the amount is accepted for pulsing.
ΣQ > N x Qmax x low flow cut-off/100
• ΣQ: totalized flow within N samples 
• N: Creep lock max number

380 Protect linearization from 
user access.

No No, Yes Read Protection of the linearization parameters. It 
is decided by the order number and cannot be 
changed.
The linearization parameters are listed in the 
device menu "Linearization"

Totalizer
400 Flow direction totalizer 1 Forward Forward, 

Reverse, 
Net

R/W Calculation principle on flow direction for for‐
ward, reverse or net flow

401 Totalizer 1 change date Last change 
date

dd-mm-
yyyy; 
hh:mm:ss

Read Date and time when totalizer 1 function was 
changed

410 Flow direction totalizer 2 Reverse Forward, 
Reverse, 
Net

R/W Calculation principle on flow direction for for‐
ward - reverse or net flow
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Parameter Default val‐
ue 

Value 
range

Access 
level

Description

411 Totalizer 2 change date Last change 
date

dd-mm-
yyyy; 
hh:mm:ss

Read Date and time when totalizer 2 function was 
changed

Pipe data
300 Number of paths Product de‐

pendent
2 R/W Number of paths on the sensor

302 Max sample frequency 15 15 Read The maximum frequency for flow measure‐
ment

303 Sample frequency 0.5 15 HW key The frequency at which the flow is measured
304 Rn for path 1 Product de‐

pendent
3.4E+38 m Read R-factor for path 1.

For FUS080/SONOKIT (retrofit) installations 
this parameter will automatically be calcula‐
ted by the pipe geometric tool (see "Pipe geo. 
assistant" in "Device" menu).

305 Rn for path 2 Product de‐
pendent

3.4E+38 m Read R-factor for path 2.
For FUS080/SONOKIT (retrofit) installations 
this parameter will automatically be calcula‐
ted by the pipe geometric tool (see "Pipe geo. 
assistant" in "Device" menu).
Valid only for 2-path solutions

306 Inner pipe diameter Product de‐
pendent

0.050 to 
1.200 m

Read Inner pipe diameter in meters.
For FUS080/SONOKIT (retrofit) installations 
this parameter will automatically be calcula‐
ted by the pipe geometric tool (see "Pipe geo. 
assistant" in "Device" menu).
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A.5 Human Interface
Table A-5 Human Interface parameters   
Parameter Default val‐

ue
Value range Access 

level
Description

420 Decimal point Automatic 
point adjust

No point; One 
digit after 
point; Two dig‐
its after point; 
Three digits af‐
ter point; Au‐
tomatic point 
adjust.

R/W Decimal numbers for displayed totalized val‐
ue

422 Operator Menu 1 All 1 to 5 Read Menu setup
1. Totalizer 1
2. Totalizer 2
3. Actual flow rate
4. Error menu
5. Display test menu
For editing, use device menu "Human Inter‐
face"

A.6 Unit conversion table
The following tables show examples of typical totalizer and flow rate units. More units are 
available via SIMATIC PDM tool. The device display can show "m3/s" unit only. Other units cannot 
be shown on the display, but will be used and shown online via PDM.  

Table A-6 Totalizer units
Unit Correction factor
Default (display supported) 1 m3

m3*100 0.01
Gallon (US) 264.1721
G*100 (100*Gallon) 2.641721
G*1000 (1000*Gallon) 0.2641721
MG (1000000*Gallon) 0.0002641721
AI (Acre Inches) 0.009728558
AF (Acre ft) 0.0008107132
CF*100 (100*ft3) 0.3531467
CF*1000 (1000*ft3) 0.03531467
I*100 (liter) 10
kI (1000*liter) 1
MI (Mega liter) 0.001
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Table A-7 Flow rate units
Flow rate Correction factor parameter
Default (display supported) 1 m3/s
m3/min (m3/minute) 60
m3/h (m3/hour) 3600
m3/d (m3/day) 86400
GPS (Gallon/second) 264.1721
GPM (Gallon/minute) 15850.32
GPH (Gallon/hour) 951019.4
GPD (Gallon/day) 22824465
MGPD (1000000*Gallon/day) 22.824465
CFS (ft3/second) 35.31467
CFM (ft3/minute) 2118.882
CFH (ft3/hour) 127132.8
I/s (liter/second) 1000
I/min (liter/minute) 60000
I/h (liter/hour) 3600000
MI/d (1000000lLiter/day) 86.4

Parameter lists
A.6 Unit conversion table
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Settings B
B.1 Factory settings

The transmitter is configured at the factory according to the order specification.
For the calibration / configuration of the flowmeter the application specific pipe dimensions 
and the specific sensor locations can require an update (for example transmitter is used with 
the SONOKIT sensor system).

Note
For type-approved and verified FUE380 flowmeter the settings are HW key protected and 
therefore read only. This HW key is protected via the verification sealing. The verification sealing 
can only be opened by the user with the acceptance of the local authorities.

Table B-1 Factory settings for 2-path sensor (DN 50 to DN 1200)   
Parameter Factory settings Possible settings 
Meter identification - Free text 15 characters 
Application location - Free text 15 characters 
Display menu Menu 1 – 5 (all) Menu 1 – 5, minimum one of the five
Pipe data 
Number of paths 2 1 or 2 
Inner pipe diameter (m) for FUE380 and FUS380 factory pre-con‐

figured according order code
May not be changed

Q max Qmax is 105% of Qs (Qs is shown on the 
system nameplate). For FUE380 and 
FUS380 factory pre-configured accord‐
ing the selection via order code.

Adjustable 

Low flow cut-off (% of Qmax) 0.25 % 
For FUE380 and FUS380 factory pre-con‐
figured. It is %-value related to the Qmax 
setting. The %-value is equal to 50% of Qi 
(Qi is shown on the system nameplate).

Adjustable (0 to 10%) 

Fliter time Factory pre-configured to typical 5 s (for 
larger pipe size higher values are used)

Adjustable (0 to 100 s)

Path 1 geometry For FUE380 and FUS380 factory pre-con‐
figured according order code

Auto set from pipe geometry help pro‐
gram in PDM

Path 2 geometry For FUE380 and FUS380 factory pre-con‐
figured according order code

Auto set from pipe geometry help pro‐
gram in PDM 

Correction factor 
Customer correction factor 1 0.5 to 1.5 
Measuring unit and factors 
Flow unit factor 3600 (for flow unit m3/h) Auto set from unit guide 
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Parameter Factory settings Possible settings 
Totalizer volume unit factor 1 Auto set from unit guide 
Flow unit text m3/h Auto set from unit guide, but only m3/h 

can be shown on display
Totalizer unit text m3 Auto set from unit guide, but only m3 can 

be shown on display 
Totalizer directions 
Totalizer 1 direction Forward Forward/Reverse/Forward net/Reverse 

net 
Totalizer 2 direction Reverse Forward/Reverse/Forward net/Reverse 

net 
Output A
Active On On/off 
Direction Factory pre-configured according order 

code. 
Preset: Forward 

Forward/Reverse/Forward net/Reverse 
net 

Amount per pulse Factory pre-configured according order 
code, i.e. 0.1 m3

Unit: The same as Totalizer unit
Value freely selectable 

Pulse width Factory pre-configured according order 
code. Typically 5 ms 

5, 10, 20, 50, 100, 200, 500 ms 

Output B
Active On On/Off 
Function Alarm Pulse/Alarm/Call up 
Direction No influence, while "Alarm" Forward/Reverse/Forward net/Reverse 

net 
Amount per pulse No influence, while "Alarm" Unit: The same as Totalizer unit

Value freely selectable
Pulse width No influence, while "Alarm" 5, 10, 20, 50, 100, 200, 500 ms 
Current output (optional add-on module)
Enable Yes Yes/No
Scaling 4 mA: always equals 0 flow rate

20 mA: equals the Qp value (product de‐
pendent)

Low flow cut-off (parameter 373) to 
Qmax (parameter 10)

Direction Forward Forward, Reverse, Bidirectional
Fixed mode No Yes/No
Fixed value 4 mA 3 to 24 mA
Alarm level 3.6 mA 3.6 mA, 22.5 mA, Off

B.2 Factory settings for Modbus communication
Parameter Default setting
Slave device address 1
Data transmission rate 19 200 baud
Parity Even

Settings
B.2 Factory settings for Modbus communication
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Parameter Default setting
Stop bit 1
Response timeout 10000 ms
Response delay 5 ms
Interframe space 35 bits

The settings can be changed by way of SIMATIC PDM or through the Modbus communication. 
To support the option with current output module the s in the preceding table are 
recommended.

B.3 Ordering of spare parts
Ensure that your ordering data is not outdated. The latest ordering data is always available on 
the Internet: Process instrumentation catalog (https://www.siemens.com/
processinstrumentation/catalogs)

Settings
B.3 Ordering of spare parts
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Product documentation and support C
C.1 Product documentation

Process instrumentation product documentation is available in the following formats: 
• Certificates (http://www.siemens.com/processinstrumentation/certificates)   
• Downloads (firmware, EDDs, software) (http://www.siemens.com/processinstrumentation/

downloads) 
• Catalog and catalog sheets (http://www.siemens.com/processinstrumentation/catalogs) 
• Manuals (http://www.siemens.com/processinstrumentation/documentation) 

You have the option to show, open, save, or configure the manual.
– "Display": Open the manual in HTML5 format
– "Configure": Register and configure the documentation specific to your plant
– "Download": Open or save the manual in PDF format
– "Download as html5, only PC": Open or save the manual in the HTML5 view on your PC

You can also find manuals with the Mobile app at Industry Online Support (https://
support.industry.siemens.com/cs/ww/en/sc/2067). Download the app to your mobile device 
and scan the device QR code.

Product documentation by serial number
Using the PIA Life Cycle Portal, you can access the serial number-specific product information 
including technical specifications, spare parts, calibration data, or factory certificates.

Entering a serial number
1. Open the PIA Life Cycle Portal (https://www.pia-portal.automation.siemens.com).
2. Select the desired language.
3. Enter the serial number of your device. The product documentation relevant for your device 

is displayed and can be downloaded.
To display factory certificates, if available, log in to the PIA Life Cycle Portal using your login 
or register.

Scanning a QR code
1. Scan the QR code on your device with a mobile device.
2. Click "PIA Portal".
To display factory certificates, if available, log in to the PIA Life Cycle Portal using your login 
or register.
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C.2 Technical support

Technical support
If this documentation does not completely answer your technical questions, you can enter a 
Support Request. 
For help creating a support request, view this video here. 
Additional information on our technical support can be found at Technical Support.   

Service & support on the Internet 
In addition to our technical support, Siemens offers comprehensive online services at Service & 
Support.

Contact 
If you have further questions about the device, contact your local Siemens representative at 
Personal Contact.
To find the contact for your product, go to "all products and branches" and select "Products & 
Services > Industrial automation > Process instrumentation".
Contact address for business unit: 
Siemens AG
Digital Industries
Process Automation
Östliche Rheinbrückenstr. 50 
76187 Karlsruhe, Germany

See also
Instructions and manuals (http://www.siemens.com/processinstrumentation/documentation)
Technical Support (http://www.siemens.com/automation/csi/service)
Partner (http://www.automation.siemens.com/partner)
Support request (http://www.siemens.com/automation/support-request)
Services & Support (http://www.siemens.com/automation/service&support)

Product documentation and support
C.2 Technical support
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